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1. はじめに 
本ドキュメントは、TeliViewer の使用方法を説明するユーザーマニュアルです。TeliViewer とは、東芝テ

リー製 USB3/GigE/CoaXPress各カメラからの画像取得/表示、およびカメラに対する各種制御を行う事が可

能なツールです。 

TeliViewer は TeliCamSDK パッケージに同梱されています。TeliCamSDK をインストールする事により利

用可能となります。 

 

1.1. 用語について 

ドキュメント内で使用する用語について説明します。 

 

用語 説明 

メインウィンドウ カメラの画像を表示する、中央に配置されたウィンドウです。 

ペイン 
Discovery、FeatureView等のカメラ操作を行うために用意されている小さな

ウィンドウを、ペインと呼称します。 

ストリーム 

ストリーミング 

カメラからの画像データをストリームと呼称します。また、カメラから画像

を取得し、表示する動作をストリーミングと呼称します。 

キャプチャー・レート カメラから画像を取得しているフレームレートを意味します。 

ディスプレイ・レート 画像を描画しているフレームレートを意味します。 

GEV GigE Vision。GigEカメラがサポートするプロトコルです。 

U3V USB3 Vision。USB3カメラがサポートするプロトコルです。 

プラグ・イン 

プラグ・アウト 

カメラをシステムへ接続する操作を、プラグ・インと呼称します。また、カ

メラをシステムから取り外す操作を、プラグ・アウトと呼称します。 

コンテキスト・メニュー 

画面をマウスで右クリックする事により表示されるメニューです。これを利

用する事により、クイック操作が可能となります。コンテキスト・メニュー

がサポートされている機能でその都度、利用方法を説明します。これを使い

こなす事により、素早い操作が可能となりますので、ご活用下さい。 

2in1モード 

4in1モード 

2in1 モードは、メインウィンドウを 2 分割し、2 つのカメラ画像を同時に表

示可能なモードです。4in1 モードは、メインウィンドウを 4 分割し、4 つの

カメラ画像を同時に表示可能なモードです。 

カレント領域 

2in1 モードあるいは 4in1 モードではメインウィンドウが複数に分割されま

す。分割された領域をマウスでクリックして選択すると、選択された領域は

赤枠で囲まれます。この赤枠で囲まれ、操作対象となっている領域をカレン

ト領域と呼称します。 

RW / RO / WO 
項目の属性を示します。RW: ReadWrite、RO: Read-Only、WO: Write-Only

を意味します。 

 便利な使い方や、推奨される使用方法等を参考情報として記載しています。 

 ご利用頂く上で、注意が必要な点について記載しています。 

 

ヒント 

注意 
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2. システム構成 
TeliViewerは、TeliCamSDKが提供する TeliCamApiを利用して動作しています。システムの構成等に関し

て詳細な情報が必要な場合、「TeliCamAPIスタートアップガイド」あるいは「TeliCamSDK for Linuxスター

トアップガイド」をご覧下さい。 

 

3. 動作環境 
基本的な動作環境に関する要件については、TeliCamSDK に準じます。詳細については、「TeliCamAPI ス

タートアップガイド」あるいは「TeliCamSDK for Linuxスタートアップガイド」に記載されている“ハード

ウェア要件”および“ソフトウェア要件”をご覧下さい。 

ここでは、TeliViewer固有の条件について説明します。 

 

3.1. 複数カメラの同時ストリーミングについて 

この後の章で説明する「マルチ・ディスプレイ」を使用すると、複数カメラを同時にストリーミングする

事が可能です。複数カメラの画像をひとつの画面上で同時に確認する事ができますので有用な機能ですが、

その反面として高いハードウェア性能が必要とされます。 

下記に、複数カメラを同時にストリーミングする場合の推奨スペックを記載します。 

 

PC推奨スペック ・CPU  : Intel Core iシリーズ第 6世代以降、4スレッド以上 

・Memory : 8Gbyte 以上  

・Graphics : 2Gbyte 以上の VRAM 搭載、OpenGL対応 

 

 

Raspberry Pi 等のシングルボード

コンピュータの利用について 

Raspberry Pi等のハードウェアスペックが低いシステム環境下では、複数カメ

ラを同時にストリーミングする事は困難である事について、ご承知おき下さい。

パケット・ロスト等のエラーが発生し、期待される動作を実現できない可能性

があります。 

ノート PCの利用について 

上記の推奨スペックを満たしていても、ノート PC 上では正常にストリーミン

グを行えない場合があります。これはシステム上のデータ・バスのデータ転送

性能に依存し、この帯域が十分でないと、パケット・ロスト等のエラーが発生

する場合があります。このような理由から、複数カメラの同時ストリーミング

を行うような場合には、データ・バスの帯域を十分に使用する事が可能な、デ

スクトップ PCのご利用を推奨します。 

 

注意 
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4. インストール 
TeliViewer は、TeliCamSDK パッケージの一部としてインストールされます。TeliCamSDK のインストー

ル方法等の詳細については、「TeliCamAPIスタートアップガイド」あるいは「TeliCamSDK for Linuxスター

トアップガイド」をご覧下さい。 

 

5. TeliViewerの起動 
TeliViewerを起動するには、下記の手順を参考にして下さい。 

 

5.1. Windows の場合 

Windows10の場合について、例を記載します。 

5.1.1. スタートメニューからの起動 

 

 

 

 

 

5.1.2. 検索を利用した起動 

 

 

 

 

 

 

5.2. Linux の場合 

ubuntuをご利用の場合について、例を記載します。 

5.2.1. 検索を利用した起動 

 

 

 

 

 

 

5.2.2. ファイラーあるいは端末からの起動 

 

 

 

 

【手順】 

1) Windowsのスタート・ボタンを押下します。 

2) TOSHIBA TELIを開きます。 

3) TeliViewerを選択し、起動します。 

【手順】 

1) Windowsのスタート・ボタンをマウスで右クリックします。 

2) 表示されるメニューの中から、[検索]を選択して開きます。 

3) 検索窓へ“TeliViewer”と入力します。 

4) 検索結果から、TeliViewer を選択し、起動します。 

【手順】 

1) タスクバー上の“アクディビティ”ボタン、あるいは Dock上の一番下にある“アプリケ

ーションを表示する”アイコンをクリックします。 

2) 検索窓が表示されますので、検索ワードへ“TeliViewer”と入力します。 

3) 検索結果から、TeliViewerを選択し、起動します。 

【手順】 

1) Nautilus等のファイラー、あるいは端末を開き、/opt/TeliCamSDK/binへ移動します。 

2) execute_TeliViewer.shスクリプトを実行し、TeliViewerを起動します。 
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6. TeliViewerの構成 
TeliViewerの基本的な構成を、下図に示します。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

各構成要素の概略について説明します。 

 

① メニューバー 

② ツールバー 

これらを使用する事により、カメラや画像に対して各種の操作を行う事が可能です。詳細については、こ

の後に続く各機能の項目で説明を行います。 

 

③ メインウィンドウ 

カメラの画像が表示される、中央に配置されたウィンドウです。2in1 あるいは 4in1 といった、複数カメ

ラの画像を同時に表示する機能もサポートされています。詳細については、「メインウィンドウ」の説明を

ご覧下さい。 

 

 

また TeliViewerには、カメラや画像に対する操作、あるいは情報を表示するための小窓が用意されていま

す。これらをペインと呼びます。TeliViewerでは、下記のようなペインがサポートされています。 

 

④ Discovery 

カメラの検索、オープン/クローズといった処理を行います。詳細については、「Discovery」の説明をご覧

下さい。 

① 

② 

③ 

⑤ 

④ 

⑥ 

⑦ 
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⑤ FeatureView 

カメラがサポートする機能をリスト表示します。表示されている各機能に対し、現在の値の確認、あるい

は設定変更を行う事が可能です。詳細については、「FeatureView」の説明をご覧下さい。 

 

⑥ Status Log 

TeliViewer 上で発生したイベントをリスト表示します。詳細については、「StatusLog」の説明をご覧下さ

い。 

 

⑦ カメラ・コントロール・ペイン 

カメラをコントロールする上でよく利用される機能が集約されています。詳細については、「カメラ・コ

ントロール・ペイン」の説明をご覧下さい。 

 

 

 

DeviceUserIDの設定について 

DeviceUserIDを使用する事により、ユーザーはカメラに対して独自の IDを

設定する事ができます。複数カメラがシステム上に存在する場合、これを

活用する事により、容易にカメラを判別する事が可能になります。 

また、TeliViewerはカメラに設定された DeviceUserIDを、カメラを識別す

るキーの一部として使用しますので、この設定は「カメラ設定の保存/復元」

や「線の描画状態の保存/復元」機能に影響を及ぼします。必須事項ではあ

りませんが、あらかじめ DeviceUserIDを適切に設定しておく事を推奨しま

す。 

※DeviceUserIDは「FeatureView」から設定する事が可能です。 

 

ヒント 
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7. TeliViewerの機能 
TeliViewerがサポートする機能について説明します。 

 

7.1. Discovery 

システム上で利用可能なカメラを検索し、カメラ・リスト上へ表示します。このリストから選択したカメ

ラをオープンする事により、カメラが利用可能になります。 

 

 

 

 

 

 

 

 

 

 

 

7.1.1. カメラ・リストの更新 

①のボタンを押下する事により、カメラ・リストが更新されます。システムへ新しくプラグ・インされた

カメラをリストへ表示するためには、このボタンを押下して下さい。また、プラグ・アウトされたカメラを

リストから消去する場合にも、同じくこのボタンを押下します。 

 

7.1.2. カメラのオープン/クローズ 

②のボタンを押下する事により、カメラ・リスト上で選択したカメラを、オープンあるいはクローズする

事ができます。カメラの状態により、ボタンの色が下記のように変化します。 

ボタン状態 説明 

の場合 選択されたカメラはクローズされた状態です。このボタンを押下するとカメ

ラがオープンされます 

の場合 選択されたカメラはオープンされた状態です。このボタンを押下するとカメ

ラがクローズされます 

 

7.1.3. カメラ・リスト 

③のカメラ・リストへシステムにプラグ・インされているカメラがリストされます。リスト上のカメラをマ

ウス、あるいはカーソルキーで選択する事により、操作対象のカメラを選択します。 

①  ②  

③  

https://www.toshiba-teli.co.jp/
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カメラの表示順について 

カメラは、“U3V devices”、“GEV devices”、“GenTL devices”の 3つのカテ

ゴリに分類されてリスト表示されます。また、各カテゴリ内のカメラは、 

ModelName + SerialNumber + DeviceUserIDをキーとし、昇順にソートされ

て表示されます。 

コンテキスト・メニューの利用 

カメラ・リスト内に表示されているカメラをマウスで右クリックすると、カ

メラをオープン/クローズするためのコンテキスト・メニューが表示されま

す。これを利用する事により上記②と同等の処理をクイック操作する事が可

能です。 

プラグ・インしたはずのカメラ

が、カメラ・リストに表示されな

い 

システムとカメラが、ケーブルを介して正しく接続されているかを再度ご確

認の上、「カメラ・リストの更新」を実行して下さい。カメラの接続状態に問

題が見当たらないにも関わらず、状況が改善されない場合、弊社ホームペー

ジよりサポート情報をご確認下さい。 

 

7.1.4. XML ファイルを利用したカメラのオープン 

 

 

この機能について 

この機能は開発者、あるいは特定ユーザー向けの機能です。正しくない XML フ

ァイルを読み込んだ場合、カメラに対する設定を正しく行えなくなる等の不具合

が発生しますので、十分にご注意の上ご利用下さい。 

 

カメラ・リスト内に表示されているカメラをマウスで右クリックすると、下図のコンテキスト・メニュー

が表示され、これを選択する事により、ホスト端末上の記憶媒体に保存された XMLファイルを使用してカメ

ラをオープンする事が可能です。 

 

 

このメニューを選択すると、読み込む XMLファイルを指定するためのダイアログが表示されますので、そ

こで使用する XML ファイルを選択します。必ず、現在オープンしようとしているカメラ向けの XML ファイ

ルを使用して下さい。 

 

 

誤った XML ファイルを使用し

てカメラをオープンしてしま

った場合 

「カメラのオープン/クローズ」手順により、カメラを一旦クローズ後、再度オ

ープンすると初期状態に戻ります。 

XMLファイルを保存したい 「XMLファイルの保存」に記載されている手順をご利用下さい。 

 

7.1.5. GigE カメラ固有の設定 

ここで説明する機能は、GigE カメラでのみご利用頂く事が可能です。 

③のカメラ・リスト上、「GEV devices」のカテゴリにリストされている GigE カメラをマウスで右クリッ

クすると、下記のようなコンテキスト・メニューが表示されますので、必要に応じてご利用下さい。 

ヒント 

注意 

ヒント 
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7.1.5.1. Access modeの選択 

オープンしようとしている GigEカメラへアクセスするモードを設定します。デフォルトは Controlアクセ

スです。基本的には、デフォルト設定のままご利用下さい。 

設定を変更する必要がある場合は、下図のメニューより希望するモードを選択後に、オープン処理を実行

します。 

 

 

 

 

 

 

各モードの詳細については、下表のとおりです。 

Access mode 意味 

Exclusive 

排他的アクセス権限でカメラをオープンします。カメラ・レジスタに対する

RW 権限を有します。このモードでオープンすると、他のホスト端末からは

当該カメラへアクセスする事ができなくなります。 

Control 

制御アクセス権限でカメラをオープンします。カメラ・レジスタに対する RW

権限を有します。このモードでオープンすると、他のホスト端末から当該カ

メラへ参照権限でのアクセスが可能です。 

Monitor 

参照アクセス権限でカメラをオープンします。カメラ・レジスタへのアクセ

ス権限は RO となりますので、カメラに対する設定変更を行う事はできませ

ん。他のホスト端末から、既に制御アクセス権限でオープンされているカメ

ラへ、参照アクセスを行いたい場合に選択します。主に、「マルチキャスト」

利用時のリスナーとして動作させる場合に使用します。 

 

7.1.5.2. IP Configuration tool の起動 

下図のメニューより、外部ツール「IP Configuration tool」を起動する事が可能です。 

 

 

 

 

 

 

これをご利用頂く事により、ネットワーク上に存在する GigE カメラに対して IP アドレス設定を変更する

事が可能です。 

 

 

7.2. メインウィンドウ 

メインウィンドウは、カメラの画像を表示するために、中央に配置されたウィンドウです。カメラから取

得した画像を表示する事に加え、画像の拡大/縮小、画像への線の描画等、ご利用を補助する多様な機能をサ

ポートしています。また、2in1/4in1 といった 1 画面上へ複数のカメラ画像を表示可能な、「マルチ・ディス

プレイ機能」にも対応しています。 

下記の説明をご理解頂きました上、これらの機能をご活用下さい。 
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7.2.1. ストリーム操作 

カメラからストリーミングを行うための操作について説明します。基本操作は、ツールバーから行う事が

できます。 

 

 

 

 

7.2.1.1. スタート 

①のボタンを押下する事により、現在選択中のカメラのストリーミングが開始されます。 

 

7.2.1.2. ポーズ 

②のボタンを押下すると、画像の更新が一時的に停止します。この時、カメラからの画像の取得は継続さ

れます。画像の更新の負荷に依存しない、実際のキャプチャー・レートの確認を行いたい場合等に使用しま

す。 

再度押下すると、画像の更新が再開されます。 

 

7.2.1.3. ストップ 

③のボタンを押下する事により、現在選択中のカメラのストリーミングが停止します。 

 

 

コンテキスト・メニューの利用 

カメラがオープンされている状態で、画像表示領域をマウスで右クリック

すると、下図のようなストリーム操作用のコンテキスト・メニューが表示

されます。 

 

 

 

 

これを利用する事によりストリームのスタート/ポーズ/ストップを、クイ

ック操作する事が可能です。 

 

7.2.2. スクロール機能 

カメラの画像が現在の表示領域をはみ出している時、スクロール機能を使用する事により、はみ出した部

分を表示し、確認する事ができます。この機能は、下記 2種類のモードをサポートしています。ご利用の状

況や、お好みに応じて、最適なモードを選択してご利用下さい。 

スクロール・モードの選択は、ストリームのスタート後に、ツールバーから行う事が可能です。 

 

 

 

 

7.2.2.1. ドラッグ・モード 

①のボタンを押下する事により、スクロール・モードがドラッグ・モードになります。このモードが選択

されている時、下記の手順で画面をスクロールする事ができます。 

また、このボタンをもう一度押下すると、ドラッグ・モードが OFFになります。 

③  ①  ②  

① ② 

ヒント 
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7.2.2.2. オート・モード 

②のボタンを押下する事により、スクロール・モードがオート・モードになります。このモードが選択さ

れている時、マウス・カーソルをカメラ画像上の任意の箇所へ移動すると、カーソルの移動に合わせて自動

的に画面がスクロールします。 

また、このボタンをもう一度押下すると、オート・モードが OFFになります。 

 

 

コンテキスト・メニューの利用 

カメラの画像が表示されている状態で、画像表示領域をマウスで右クリ

ックすると、下図のようなスクロール・モード切り換え用のコンテキス

ト・メニューが表示されます。 

 

 

 

これを利用する事によりスクロール・モードの切り替えを、クイック操

作する事が可能です。 

 

7.2.3. 画像の拡大/縮小 

カメラの画像を拡大、あるいは縮小する操作について説明します。基本的な操作はツールバーから行う事

ができます。また、それに加え、ホイール搭載型マウスをご利用の場合、このマウス・ホイールを使用した

拡大/縮小操作にも対応しています。 

指定可能な倍率は、3%～800%の範囲です。 

 

 

 

 

7.2.3.1. スライダーの利用 

①のスライダーのハンドル(つまみ)部分をマウスでドラッグする事により、値を連続的に変更する事がで

きます。また、ガイド部分をクリックすると、細かなステップで表示倍率の設定を行う事ができます。 

変更した結果は、④へ自動的に反映されます。④の値を確認する事により、現在の実際の値を確認できま

す。 

 

7.2.3.2. フィット表示 

②のボタンを一度押下すると、画像表示モードがフィット・モードになります。フィット・モードでは、

下記の条件で画像を表示し続けます。 

ヒント 

① 
② ③ ④ 

【手順】 

1) マウス・カーソルがカメラ画像上にある時、カーソルの形態が上図①と同じ「手のひら」

の状態となっている事をご確認下さい 

2) カメラ画像上の任意の箇所をマウスの左ボタンでクリックします 

3) クリックしたままの状態でマウスを移動(ドラッグ)すると、画面がスクロールします 

4) マウスの左ボタンを放します 

5) 上記手順 2 ～ 手順 4 の操作を繰り返す事により、目的とする座標へ移動します 

https://www.toshiba-teli.co.jp/
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画像方向 表示効果 

画像の垂直方向 画像表示領域の高さへフィット 

画像の水平方向 画像表示領域へセンタリング 

ウィンドウサイズを変更した場合でも、上記条件の下で画像を表示し続けます。フィット・モードは、こ

の章で説明している①、③、④、あるいは Ctrlキー＋マウス・ホイールの操作を行うと解除されます。 

 

 

コンテキスト・メニューの利用 

カメラの画像が表示されている状態で、画像表示領域をマウスで右クリ

ックすると、下図のように「Fit Image」コンテキスト・メニューが表示

されます。 

 

 

これを利用する事によりフィット・モードへの移行を、クイック操作す

る事が可能です。 

 

7.2.3.3. 等倍(100%)表示 

③のボタンを押下すると、表示倍率が等倍(100%)表示になります。 

 

 

コンテキスト・メニューの利用 

カメラの画像が表示されている状態で、画像表示領域をマウスで右クリ

ックすると、下図のように「Zoom 100%」コンテキスト・メニューが

表示されます。 

 

 

これを利用する事により等倍表示への移行を、クイック操作する事が可

能です。 

 

7.2.3.4. スピン・ボックスの利用 

④を利用する事により、値の直接入力、あるいは、スピン・ボタンを利用した細かなステップでの値の変

更が可能です。 

変更した結果は、①へ自動的に反映されます。 

 

7.2.3.5. Ctrl キー ＋ マウス・ホイールの利用 

※この操作を行うには、ホイール搭載型マウスが必要です。 

表示倍率を変更したい画像表示領域をクリックして選択した後、Ctrl キーを押下しながらマウス・ホイー

ルを Up、Downする事により画像の拡大/縮小が可能です。 

操作 効果 

Ctrlキー ＋ マウス・ホイール Up 画像の拡大 

Ctrlキー ＋ マウス・ホイール Down 画像の縮小 

 

 

ヒント 

ヒント 
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7.2.4. カメラ画像の保存 

現在表示されているカメラの画像を、静止画として保存する事が可能です。静止画を保存する場合、ツー

ルバー上の下図のボタンを押下します。 

 

 

 

7.2.4.1. 画像保存ダイアログ 

①のボタンを押下すると、下図のダイアログが表示されます。 

 

 

 

 

 

 

 

 

7.2.4.2. 描画中の線の保存 

②は、「線の描画」設定で Gridあるいは 4x4の描画が有効になっている場合に、選択可能になります。こ

れをチェックする事により、現在の画像とともに描画されている線をファイルへ保存する事が可能です。 

 

 

RAW フォーマットでの保存

について 

この後選択するファイルのフォーマットへ“RAW”形式を選択した場合、描画中

の線は保存する事ができませんので、ご注意下さい。 

 

7.2.4.3. 保存先の選択 

③のボタンを押下すると、下図のダイアログが表示されます。ここで、ファイルの保存先のフォルダ、フ

ァイル名、およびファイルの種類(保存するファイルのフォーマット)を指定します。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

① 

② 

③ 

注意 

④ 

⑤ 

⑥ 

⑦ 
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7.2.4.4. フォルダの選択 

④により、ファイルを保存するシステム上のフォルダを選択します。 

 

7.2.4.5. ファイル名の選択 

⑤へ保存するファイル名を指定します。初期状態では「Image_yymmdd_hhmmss」形式のファイル名が

表示されますが、必要に応じてファイル名を変更して下さい。 

(yymmdd: ③を押下した時点の年月日、hhmmss: ③を押下した時点の時分秒) 

 

7.2.4.6. ファイルの種類(保存するファイルのフォーマット)の選択 

⑥では、下記の 4種類のフォーマットがサポートされています。ご利用の目的に応じて何れかを選択して

下さい。 

フォーマット 説明 

PNG 

PNG形式で画像を保存します。 

ビット深度は、8/16/24/32/48bpp(bits per pixel)の何れかを

選択する事が可能です。 

JPG JPG形式で画像を保存します。 

BMP 

BMP形式で画像を保存します。 

ビット深度は、8/24/32bpp(bits per pixel)の何れかを選択す

る事が可能です。 

RAW RAW形式で画像を保存します。 

 

7.2.4.7. RAW形式のヘッダー情報 

RAW形式で画像を保存した場合、保存されたファイルの先頭部分には下記に示す 32バイトのヘッダー情

報が含まれます。このヘッダー情報の直後に実際の画像データが保存されています。 

構成要素 
サイズ 

(バイト) 
説明 

フラグ 4 RAW形式を示す 0x00574152が常に格納されます。 

ファイルサイズ 4 このファイルのサイズが格納されます。 

画像フォーマット 4 このファイルの画像フォーマットが格納されます。 

幅 4 画像の幅が格納されます。 

高さ 4 画像の高さが格納されます。 

予約領域 12 将来の拡張用に予約された領域です。 

 

7.2.4.8. 保存ボタン 

⑦のボタンを押下すると、指定したファイルへデータが保存されます。 
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トリガ・モードの併用 

「トリガ・モード」を使用する事により、保存したい画像を着実に捕捉

する事が可能となります。必要に応じて、トリガ・モードをご利用頂く

事もご検討下さい。 

トリガ・モードは、「カメラ・コントロール・ペイン」の「Trigger」ペ

インからご利用頂く事が可能です。 

 

 

7.2.5. ルーペ・ツール 

ツールバー上のルーペ・ボタンを押下する事により、画像を部分的に拡大する事が可能なルーペ・ツール

を使用する事ができます。 

ルーペの拡大倍率は、2倍です。 

 

 

 

7.2.5.1. ルーペの起動 

①のボタンを押下する事により、ルーペ・ツールが開きます。ルーペは、現在のマウス・カーソルに合わ

せて移動します。もう一度ボタンを押下すると、ルーペ・ツールが閉じます。 

下図は、ルーペ・ツールが有効化され、画像を部分的に拡大したイメージです。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

コンテキスト・メニューの利用 

カメラの画像が表示されている状態で、画像表示領域をマウスで右クリ

ックすると、下図のように「Loupe」コンテキスト・メニューが表示さ

れます。 

 

 

これを利用する事によりルーペの起動を、クイック操作する事が可能で

す。 

 

① 

ルーペにより、 

拡大された画像 

ヒント 

ヒント 
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7.2.6. 線の描画 

ストリーミング中に、この機能を使用する事により、表示されている画像へ線を描画する事が可能です。

線を描画するには、メニューバー上の①、あるいはツールバー上の②のいずれかを選択します。どちらを選

択した場合も、同じダイアログが表示されます。 

 

 

 

 

 

上記の操作により、「Grid/4x4 Settings」ダイアログが開きます。Grid、4x4のそれぞれの使い方は下記の通

りです。 

 

7.2.6.1. Grid の描画 

「Grid/4x4 Settings」ダイアログ上で、「Grid Settings」タブを選択する事により、次の画面が表示されま

す。また、Gridの設定により、実際に Grid線が描画された状態が右の画像になります。 

線の太さは、1Pixelで固定です。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

① Draw Gridチェックボックス 

これをチェックする事により、Gridが表示されます。 

② Horizontal Pitch 

水平方向の線の間隔を設定します。設定する値の単位は Pixelです。 

③ Vertical Pitch 

垂直方向の線の間隔を設定します。設定する値の単位は Pixelです。 

④ Color 

このボタンを押下すると、線の色を選択するためのダイアログが表示されます。ここで線の色を変更する

事が可能です。 

① あるいは ② 

① 

② 

③ 

④ 

Horizontal 

Pitch 

Vertical 

Pitch 
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7.2.6.2. 4x4の描画 

「Grid/4x4 Settings」ダイアログ上で、「4x4 Settings」タブを選択する事により、次の画面が表示されま

す。この機能を使用する事により、水平方向 4本、垂直方向 4本の線を画像に描画する事ができます。 

また、4x4の設定により、実際に 4x4線が描画された状態が右の画像になります。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

① Draw 4x4チェックボックス 

これをチェックし、更に②、③をチェックする事により、4x4の各線が表示されます。 

② H1～H4 (Horizontal Line #1～#4) 

水平線を描画します。「①: Draw 4x4チェックボックス」をチェック後、更に H1から H4までの何れかを

チェックすると、該当する水平方向の線が描画されます。 

③ V1～V4 (Vertical Line #1～#4) 

垂直線を描画します。「①: Draw 4x4チェックボックス」をチェック後、更に V1から V4までの何れかを

チェックすると、該当する垂直方向の線が描画されます。 

④ Position 

線を描画する位置を指定します。値を指定する単位は Pixel です。水平線、垂直線の設定とその効果につ

いては下記の通りです。 

Position設定 効果 

H1～H4 

(水平線) 
画像左上を起点とし、そこから Y 軸方向へ指定 Pixel の位置に、水平線を描画 

V1～V4 

(垂直線) 
画像左上を起点とし、そこから X 軸方向へ指定 Pixel の位置に、垂直線を描画 

 

⑤ Width 

線の幅を指定します。値を指定する単位は Pixelです。1～10の値を設定する事ができます。 

⑥ Color 

このボタンを押下すると、線の色を選択するためのダイアログが表示されます。ここで各線の色を変更す

る事が可能です。 

① 

② 

③ 

④ ⑤ 
⑥ 

https://www.toshiba-teli.co.jp/
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7.2.6.3. 4x4のマウスによる移動 

画像に描画されている 4x4の各線は、マウスのドラッグ操作により移動する事が可能です。下記の手順を参

考に、操作を行って下さい。 

 

【手順】 

1) 前項の「4x4の描画」手順により、線を描画します。 

2) 描画されている線へマウス・カーソルを移動させます。 

3) マウスの左ボタンをクリックし、線をドラッグして移動させます。 

4) 移動させたい場所へ線の移動が完了したら、マウスの左ボタンを解放します。 

5) 以上の操作により、線を画像上の任意の場所へ移動する事が可能です。 

 

 

 

スクロール設定がドラッ

グ・モードの場合 

「ドラッグ・モード」が選択されている場合、この機能を使用する事が

できません。一旦、ドラッグ・モードを解除の上、ご利用下さい。 

 

 

 

コンテキスト・メニューの利用 

カメラの画像が表示されている状態で、画像表示領域をマウスで右クリ

ックすると、下図のようなコンテキスト・メニューが表示されます。 

 

 

 

 

1) Draw Grid 

Gridの ON/OFFをここから切り替える事ができます。「Grid」の

操作説明内で、①の操作を行ったのと同じ効果を得られます。 

2) Draw 4x4 

4x4の ON/OFFをここから切り替える事ができます。「4x4」の操

作説明内で、①の操作を行ったのと同じ効果を得られます。 

3) Grid/4x4 Settings 

「Grid/4x4 Settings」ダイアログを開きます。 

これらを利用する事により Grid/4x4の描画設定を、クイック操作する事

が可能です。 

線の描画状態の保存/復元 

(Save and restore Grid/4x4 

settings) 

オプション設定を開き、チェックボックス「Save and Restore Grid/4x4 

settings」をチェックされた状態に設定する事で、現在の線の描画状態

を保存、あるいは復元する事が可能です。 

設定の保存は、カメラがクローズされる時に実行されます。データは“線

の設定データ・ファイル”へ保存されます。 

また、カメラをオープンするときにデータが復元されます。現在のカメ

ラの「モデル名/シリアルナンバー/DeviceUserID」の 3 つのキーが一致

する“線の設定データ・ファイル”が存在する場合、復元されます。 

 

 

カメラの DeviceUserIDを変更した場合、“線の設定データ・ファイル”

に保存されている DeviceUserID と一致しなくなるため、以前に保存さ

れたデータは復元できなくなりますのでご注意下さい。 

 

ヒント 

注意 

注意 
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7.2.7. タブ操作 

画面が通常モード(マルチ・ディスプレイではない)表示のとき、複数カメラをオープンすると、表示領域上

部に下図のようなタブが表示されます。このタブの操作について説明します。 

 

 

 

 

7.2.7.1. カメラ選択の切り換え 

タブをマウスで左クリックする事により、カメラの選択を切り換える事ができます。 

 

7.2.7.2. タブの分離 

タブをダブルクリックすると、タブを分離する事ができます。分離した事により、画像表示領域が単独のウ

ィンドウとして表示されます。これを活用する事で、画像表示領域をお好みのレイアウトに配置してご利用頂

く事が可能です。 

また、分離されたウィンドウのタイトルバーをダブルクリックすると、再度タブ化され、元の状態に戻りま

す。 

 

7.2.8. マルチ・ディスプレイ 

メニューバー上で「Multi-Display」をクリックすると、下図のように 2in1 あるいは 4in1 を選択する事が

可能です。この何れかを選択する事により、マルチ・ディスプレイ・モードへ移行します。 

下図は、2in1がチェックされており、2in1モードで動作している状態です。これを再度クリックするとチ

ェック状態が解除され、通常モードへ戻ります。この動作は 4in1についても同様です。 

 

 

 

 

 

 

 

モード変更時の注意 
カメラがオープンされている状態でモード変更を行うと、オープンされていたカ

メラは一旦強制的にクローズされますのでご注意下さい。 

マルチ・ディスプレイ・モー

ドの必要条件について 

マルチ・ディスプレイ・モードで複数カメラを同時にストリーミングするには、

高いハードウェア性能が必要とされます。要件等については「動作環境」の説明

をご確認下さい。 

 

7.2.8.1. 2in1 

①を選択する事により 2in1 モードへ移行します。2in1 モードでは、メインウィンドウで 2 つのカメラ画

像を同時に確認する事が可能です。 

2in1モードでカメラ画像を表示する手順について説明します。 

注意 

① 

② 
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【手順】 

1) マウスを使用し、分割された画像表示領域の何れかを選択します。現在選択されている領域(カレン

ト領域)は、赤枠で囲まれます。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2) Discoveryの「カメラ オープン/クローズ」の手順に従い、カレント領域へカメラをオープンします。 

6) ストリーム操作の「スタート」手順で、カレント領域のカメラに対するストリーミングを開始します。 

7) マウスを使用し、カメラがオープンされていない領域を選択し、カレント領域を変更します。 

8) 以下、2)～4)の手順を繰り返し、画像を確認したいカメラ全てのストリーミングを開始します。 

 

7.2.8.2. 4in1 

②を選択する事により 4in1 モードへ移行します。4in1 モードでは、メインウィンドウで 4 つのカメラ画

像を同時に確認する事が可能です。 

4in1モードでカメラ画像を表示する手順について説明します。 

 

【手順】 

1) マウスを使用し、分割された画像表示領域の何れかを選択します。現在選択されている領域(カレン

ト領域)は、赤枠で囲まれます。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

カレント領域 

カレント領域 

https://www.toshiba-teli.co.jp/
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2) Discoveryの「カメラ オープン/クローズ」の手順に従い、カレント領域へカメラをオープンします。 

3) ストリーム操作の「スタート」手順で、カレント領域のカメラに対するストリーミングを開始します。 

4) マウスを使用し、カメラがオープンされていない領域を選択し、カレント領域を変更します。 

5) 以下、2)～4)の手順を繰り返し、画像を確認したいカメラ全てのストリーミングを開始します。 

 

 

コンテキスト・メニューの利用 

カメラ・オープン 

のクイック操作 

カメラがオープンされていない状態で、カレント領域を

右クリックすると、下図のようなカメラ・オープン・メ

ニューが表示されます。 

 

 

 

 

これを利用する事により、カメラ・オープンをクイック

操作する事が可能です。Discoveryペインが表示されな

いフル・スクリーン・モードでも、これを利用する事で

カメラのオープンが可能です。 

カメラ・クローズ 

のクイック操作 

カメラがオープンされている状態で、カレント領域を右

クリックすると、下図のようなカメラ・クローズ・メニ

ューが表示されます。 

 

 

これを利用する事により、カメラ・クローズをクイック

操作する事が可能です。例えばフル・スクリーン・モー

ド中に、カメラの画面配置を変更したい場合、このクロ

ーズ・コンテキスト・メニューと上記のオープン・コン

テキスト・メニューを利用する事で、容易に配置の変更

を行う事が可能です。 

2in1/4in1モード時、

特定カメラへ表示をフ

ォーカスしたい 

カメラ画像が表示されている状態で、表示領域を右クリ

ックすると、下図のようなコンテキスト・メニューが表

示されます。 

 

 

これを選択する事により、現在の画像を単独でフル・ス

クリーン表示する事ができます。特定の画像へフォーカ

スしたい場合にご利用下さい。 

スクロール・バーを表示したい、 

あるいは非表示にしたい 

分割された各画像表示領域へのスクロール・バー表示設定については、「Display 

Scrollbar」の説明をご確認下さい。 

 

 

「フィット表示」中は、スクロール・バーは表示されません。 

現在のフレームレート、座標場情

報、RGB 構成値を表示したい、

あるいは非表示にしたい 

情報表示については、「タブ・バー」または「オーバーレイ」を選択する事がで

きます。最適な方法をお好みにより選択して頂く事が可能です。 

 

ヒント 

注意 
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7.2.9. フル・スクリーン表示 

ツールバー上のフル・スクリーン・ボタンを押下する事により、画像をフル・スクリーンで表示する事が

可能です。 

 

 

 

7.2.9.1. フル・スクリーン表示の開始 

①を押下する事により、現在のメインウィンドウをフル・スクリーンで表示する事が可能です。フル・ス

クリーンは、下記の状態でご利用可能です。 

表示モード 効果 

通常モード 
ひとつのカメラ画像が表示されている通常モード状態のとき、①を押

下すると、現在の画像がフル・スクリーンで表示されます。 

2in1モード 
2in1モード状態でカメラ画像を表示しているとき、①を押下すると、

フル・スクリーンで 2in1表示されます。 

4in1モード 
4in1モード状態でカメラ画像を表示しているとき、①を押下すると、

フル・スクリーンで 4in1表示されます。 

 

7.2.9.2. フル・スクリーン表示の終了 

ESCキーを押下すると、元の画面に戻ります。 

 

① 
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7.2.10. イメージの詳細設定 

メニューバーから[Image] -> [Settings]を選択すると、下図のような Image Settingsダイアログが表示され

ます。 

ここでは、画像を描画するときの設定を変更する事ができます。 

 

 

 

 

 

 

 

 

 

 

 

 

7.2.10.1. Bayer convert option 

画像フォーマットがベイヤータイプのときに使用する、画素補間方式を選択します。Bi-Linear、ACPI、

No conversionの 3種類から選択する事が可能です。 

デフォルトは、Bi-Linear です。 

 

 

ACPIの利用ついて 
ACPI は、ベイヤー8 ビットでのみ利用可能です。ベイヤー10 ビット、あるいは

12ビットが選択されている場合、ACPIを選択する事はできません。 

 

7.2.10.2. Interpolation display method 

画像を拡大/縮小したときの、画素補間方式を選択します。Nearest neighbor と Bi-Linearの 2種類から選

択する事が可能です。 

デフォルトは、Nearest neighborです。 

 

7.2.10.3. Set maximum display rate 

ディスプレイ・レートの上限値を設定する事が可能です。 

例えば、ハードウェア性能の低い環境下で、キャプチャー・レートがカメラ性能の最大値を達成できてい

ないとき、多くの場合、原因は画像表示にシステム・リソースを奪われている事に起因します。その場合、

ディスプレイ・レートの上限を制限する事により、「最大キャプチャー・レートを維持したストリーミング

が可能なディスプレイ・レート」を確認する事ができます。 

具体的には、下記の手順を参考にして下さい。 

 

 

 

 

 

 

 

【手順】 

1) Set maximum display rateをチェックし、この機能を有効化する 

2) スピン・ボックスへ、ゼロを設定する 

3) キャプチャー・レートの値を確認する 

4) スピン・ボックスの値を、1～2程度の小さなステップで上げる 

5) 上記、手順 3～手順 4を繰り返し、最大キャプチャー・レートを維持可能なディスプレイ・レートを見つける 

注意 
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なお、ここに設定可能な最大値は、ご利用中のディスプレイのリフレッシュレートに依存します。 

 

7.2.10.4. Image processing 

画像展開処理を CPUと GPUのどちらで実施するかを選択します。デフォルトは GPUモードです。 

GPU モードで画像を処理する事により、CPU 負荷を低く抑える事が可能です。これにより、他のプロセ

スに対する影響も低減化され、システム全体がスムーズに稼働できる見込みが高くなります。 

基本的には、GPU モードのままご利用下さい。GPU モードで利用中に、画像表示に何かしらの問題が発

生した場合のみ CPUモードへ切り替えて、改善があるかをご確認下さい。 

なお、ご利用中の環境によっては GPUモードを選択できない場合があります。その場合は自動的に CPU

モードで動作します。 

 

 

GPU選択時と CPU選択時で、

CPU 使用率に変化が見られな

い場合 

現在ご利用中のグラフィック・カードに対して最適なドライバがインス

トールされていない場合、GPU 処理が適切に動作しない場合がありま

す。最適なドライバの入手方法については、各グラフィック・カードの

ベンダーの、ホームページ等をご確認下さい。 

 

ヒント 

https://www.toshiba-teli.co.jp/


 

. 

 

 

29 

Copyright © 2021 - 2023 Toshiba Teli Corporation, All rights reserved.  https://www.toshiba-teli.co.jp/ 

 

DAA02812C 

 

7.3. FeatureView 

現在オープンされているカメラがサポートする機能をリスト表示します。表示されている各項目の現在の

値を表示し、編集可能項目に対しては、編集手段を提供します。 

FeatureViewは、ツールバー、機能リスト、Favorites(お気に入り)リスト、Description(項目説明)領域で構

成されます。これらのご利用方法について説明します。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

7.3.1. ツールバー 

ツールバーは、下図のように構成されています。ここへ実装されている各機能の操作方法について説明し

ます。 

 

 

 

 

 

 

 

7.3.1.1. 更新ボタン 

①を押下する事により、機能リスト、および Favoritesリストが最新状態に更新されます。 

① ② ③ ④ ⑤ 

⑥ ⑦ 

⑧ ⑨ 

ツールバー 

機能リスト 

Favorites リスト 

Description 
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7.3.1.2. 表示形式選択ボタン 

②の選択により、機能リストの表示形式を変更する事ができます。詳細は下記の通りです。 

ボタン種別 効果 

ボタン カテゴリ別に表示します。 

ボタン アルファベット順にソートして表示します。 

 

7.3.1.3. 表示フィルタ切り換えボタン 

③の選択を変更する事により、機能リストに表示される項目をフィルタリングする事ができます。カメ

ラがサポートする各項目には、Beginner/Expert/Guruの属性が存在し、下記の何れかを選択する事により表示

項目の切り替えが可能です。 

表示モード 効果 

ボタン Beginnerモードを選択します。 

ビギナー向けの項目のみが表示されます。 

ボタン Expertモードを選択します。 

ビギナー、およびエキスパート向けの項目が表示されます。 

ボタン Guruモードを選択します。 

ビギナー、エキスパート、およびグル向けの項目が表示されます。 

 

7.3.1.4. Favoritesリスト表示ボタン 

④を押下する事により、Favorites(お気に入り)リスト表示の ON/OFFを切り替えます。 

 

7.3.1.5. カメラ設定の保存/復元 

⑤を押下すると、下図のようなカメラ設定の保存、あるいは復元を行うためのサブメニューが表示され

ます。これらの利用方法について説明します。 

 

 

 

 

 

 

(A) 

(B) 

https://www.toshiba-teli.co.jp/
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7.3.1.5.1. Load features 

(A)を選択する事により、下図のダイアログが開きます。ここで、あらかじめ「Save features」の手順

で保存されたファイルを選択する事により、カメラ設定を復元する事ができます。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

カメラがストリーミング中

の場合 

Load feature機能は、カメラがストリーミング中の場合には利用できません。カ

メラのストリーミングを一旦停止してからご利用下さい。 

モデル名が異なる設定ファ

イルを選択したとき 

現在オープンされているカメラと異なるモデル名が保存されている設定ファイ

ルを復元しようとした場合、下図の警告が表示されます。 

 

 

 

 

 

 

 

この場合、Cancelを押下し、操作を中断する事を推奨します。OKを押下して継

続すると、多くの場合は復元に失敗し、予期せぬ復元結果を招く事になります。

OK を押下する事により継続する事はできますが、これによりカメラ状態に異常

が発生した場合、ご利用者様の責任となりますので十分にご注意下さい。 

誤ったファイルを復元して

しまった場合 

操作の誤りにより、間違ったファイルを復元してしまい、カメラ動作に異常が発

生した場合は、カメラの再プラグ・イン、あるいは Device Reset を実行する事

により、カメラを初期状態へ戻す事が可能です。 

 

注意 

https://www.toshiba-teli.co.jp/
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7.3.1.5.2. Save features 

(B)を選択する事により、現在のカメラ設定をファイルへ保存します。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

➢ ファイル名 

 (C)には、ファイル名の初期値が表示されます。これは (モデル名 )_(シリアルナンバ

ー)_(DeviceUserID)で構成された文字列です。適宜、ご利用者が解かりやすいファイル名に変更して

ご利用下さい。 

➢ ファイルの種類 

(D)では、tcf(TELI camera features) 形式のみが選択可能です。この形式のみが、(A)で復元対象の

設定ファイルとなります。 

 

 

CoaXPressカメラでのご利

用について 

CoaXPressカメラでは、カメラが保有している設定と、キャプチャーボードが保

有している設定があります。キャプチャーボードの設定は、一部のみが保存され

ます。キャプチャーボード設定の全ては保存されない事についてご注意下さい。 

 

(C) 

(D) 

注意 
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7.3.1.6. XML ファイルへの保存 

⑤を押下すると、現在オープンされているカメラの Feature リストを XML ファイルへ保存するための

サブメニューが表示されます。 

 

 

 

 

 

 

(C)を選択すると、ファイルへ保存するためのダイアログが表示されますので、ファイル名と保存先を

選択後、[保存]ボタンを押下する事により、ファイルへ保存します。 

 

7.3.1.7. アクセス・モジュールの選択 

※この項目は、現在オープンしているカメラが GenTL デバイスのときにのみ有効です。USB3 カメラ、

あるいは GigEカメラではご利用できません。 

⑥の選択を変更する事により、各モジュール事の設定項目を表示します。 

選択項目 意味 

RemoteDevice 
RemoteDevice にカテゴライズされた項目を表示します。ここへはカメラが

保持している設定項目が表示されます。 

System 
System にカテゴライズされた項目を表示します。ここへはキャプチャーボ

ードが保持している設定項目が表示されます。 

Interface 
Interface にカテゴライズされた項目を表示します。ここへはキャプチャーボ

ードが保持している設定項目が表示されます。 

Device 
Deviceにカテゴライズされた項目を表示します。ここへはキャプチャーボー

ドが保持している設定項目が表示されます。 

Stream 
Stream にカテゴライズされた項目を表示します。ここへはキャプチャーボ

ードが保持している設定項目が表示されます。 

 

7.3.1.8. GenICamキャッシュの設定 

⑦の選択を変更する事により、GenICamキャッシュの ON/OFFを切り替える事ができます。 

これは開発者用の設定です。デフォルト設定は ONです。通常は ONのままご利用下さい。 

例えば、カメラ・レジスタへ Writeコマンドを用いて直接値の書き換えを行った後、現在の値を機能リ

スト、あるいは Favoritesリストへ反映したい場合、このチェックボックスを OFFにしてから、①の更新

ボタンを押下します。この操作により、キャッシュへ保存されている値ではなく、カメラ・レジスタに保

存されている現在の値を直接取り出す事が可能です。 

なお、OFF に設定して使用した場合、カメラとの I/O パフォーマンスが低下する場合がありますので、

ご注意下さい。 

 

7.3.1.9. 文字列検索 

⑧へ入力された文字列を使用し、機能リストに対して case-insensitive(大文字と小文字を区別しない)

な検索を実施します。入力された文字列を部分的に含む項目を全て検索し、検索結果は機能リストへ表示

されます。 

(C) 

https://www.toshiba-teli.co.jp/
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7.3.1.10. 検索文字列消去ボタン 

⑨のボタンを押下すると、文字列検索へ入力された文字列が一括消去されます。 

Ctrlキー ＋ Delボタンを押下すると、このボタンを押下したのと同じ効果を得る事ができます。 

 

7.3.2. 機能リスト 

カメラがサポートする機能を、リスト表示します。 

 

 

 

 

 

 

 

 

 

 

 

 

7.3.2.1. 文字色の説明 

リスト中の各項目は、色分けされて表示されます。各色の持つ意味は下記の通りです。 

項目色 意味 

黒 
項目の属性が、RW(ReadWrite)である事を示します。値を編集する事が可能

です。 

茶色 
項目の属性が、RO(Read-Only)である事を示します。値は変更する事ができ

ません。 

緑 
項目の属性が、WO(Write-Only)である事を示します。この項目のエディタを

開くと、コマンド・ボタンが表示されます。 

 

7.3.2.2. 値の編集方法 

項目の属性が RWあるいは WOの項目に対しては、値変更用のユーザーインターフェースをオープンする事

により、編集が可能となります。この編集を行うためのユーザーインターフェースを、エディタと呼びます。

エディタに対する主な操作方法について説明します。 

 

7.3.2.2.1. エディタのオープン・クローズ 

下記の操作により、エディタをオープンあるいはクローズする事ができます。エディタをオープンする事に

より、編集操作が可能になります。 

https://www.toshiba-teli.co.jp/
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操作 効果 

エディタのオープン 
・マウスの左クリック 

・“Name”列上の項目が選択されている状態から、右矢印キー(→)の押下 

エディタのクローズ 

・オープンされているエディタ以外の場所をマウスの左クリック 

・Enterキーの押下 

・ESCキーの押下 

 

7.3.2.2.2. 値の編集 

エディタには下記のような種類が存在します。それぞれの値の変更方法について説明します。 

種類 説明 

ラインエディット 

整数値、小数値、文字列を直接入力する事が可能です。 

また、GigEカメラでは IPアドレスもラインエディットで入力可能です。 

入力可能な値の形式は、項目によって異なります。詳細についてはカメラ

の取り扱い説明書をご確認下さい。 

ドロップダウン・リスト 
エディタをオープンする事により、選択可能な値がリスト表示されますの

で、設定したい値を選択します。 

コマンド・ボタン 表示されたボタンを押下する事により、選択された操作が実行されます。 

複合エディタ 

ラインエディットとスライダーの両方が利用可能なエディタです。 

お好みにより、これらを使い分けて設定を行って下さい。 

 

 

・Tabキーの利用 

ラインエディットとスライダーのフォーカスを切り換える場合、マウス

による操作以外にも Tabキー、あるいは Shift+Tabキーを押下する事で切

り換えが可能です。 

 

 

 

 

 

7.3.3. Favorites(お気に入り)リスト 

よく使う機能を登録する事により、クイック・アクセスが可能になります。ここに登録された機能は、次回

の TeliViewer起動時に復元されます。 

 

 

 

 

 

 

 

 

 

 

 

ヒント 

① ② ③ 

④ 

Tabキーの押下によりフォーカス移動 
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7.3.3.1. 項目の追加 

「機能リスト」上で項目を選択し、①を押下すると、Favoritesリストへ項目が追加されます。 

 

7.3.3.2. 項目の削除 

Favoritesリスト上で項目を選択し、②を押下すると、Favorites リストから項目が削除されます。 

 

7.3.3.3. 項目の全削除 

③を押下すると、Favoritesリスト上の全ての項目が削除されます。 

 

7.3.3.4. 項目の並べ替え 

Favoritesリスト上の項目を選択後、④の上矢印、あるいは下矢印ボタンを押下する事により、項目を上下に

移動する事が可能です。お好みで使い易い順番に並べ替えてご利用頂く事が可能です。 

 

7.3.3.5. 値の編集方法 

値を編集する方法については、機能リスト上での操作と同じです。詳しくは、機能リストの「値の編集方法」

をご覧下さい。 

 

7.3.4. Description(項目説明)領域 

機能リスト、あるいは Favorites リスト上で項目を選択すると、その項目に対する詳細な説明がこの領域へ

下図のように表示されます。各項目に対する詳細な説明が必要な場合、この表示内容をご覧下さい。 

 

 

 

 

 

 

ツール・チップの表示① 

(項目名称と説明) 

機能リスト、あるいは Favorites リストの名前部分へマウス・カーソルを移動

させると、下図のようにツール・チップが表示されます。 

 

 

 

 

 

 

これを利用する事により、項目名称の一部隠れてしまっている場合に、項目名

称全体を確認する事ができます。また項目の簡易説明が表示されますので、参

考として下さい。 

ツール・チップの表示② 

(設定可能値の確認) 

値の設定範囲が定義されている項目の場合、エディタ部分へマウス・カーソル

を移動させると、下図のように Min/Max/Incのそれぞれの値が表示されます。 

 

 

 

値の設定可能範囲を確認したいときに、ご利用下さい。 

ヒント 
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コンテキスト・メニューの利用 

Favorites リストへの 

アイテムの追加 

機能リスト上の項目を右クリックすると、下図のメ

ニューが表示されます。 

 

 

これを使用する事で Favorites リストへの登録をク

イック操作する事が可能です。 

Favorites リストの 

操作 

Favorites リスト上の項目を右クリックすると、下図

のメニューが表示されます。 

 

 

 

 

これを使用する事で Favoritesリスト内の、項目の並

べ替え、および項目の削除をクイック操作する事が

可能です。 

 

7.4. StatusLog 

TeliViewer上で発生したイベントをリスト表示します。 

 

 

 

 

 

 

 

 

 

 

7.4.1. イベント・リストの消去 

①を押下すると、イベント・リストに表示されている全てのイベントが消去されます。 

 

7.4.2. イベント・フィルタ選択 

②の何れかのボタンを押下する事で、表示されるイベントをフィルタリングする事ができます。 

フィルタ 効果 

ボタン Error 情報が表示されます。イベント・タイプが ERR に該当するものが対

象となります。処理を継続不可能なエラーが発生した事を示します。 

ボタン Warning情報が表示されます。イベント・タイプが WRN に該当するものが

対象となります。処理を継続可能なエラーが発生した事を示します。 

ボタン Info情報が表示されます。イベント・タイプが INFO に該当するものが対象

となります。エラーではない状態変化等が発生した事を示します。 

 

① ② 

③ 

④ 
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7.4.3. イベント・リスト 

③には、発生したイベントがリスト表示されます。リスト内の各項目について説明します。 

項目 説明 

Data/Time イベントが発生した日時を表示します。 

Camera 
イベントが発生したカメラの、モデル名、シリアルナンバー、DeviceUserIDが表示

されます。 

Type 
発生したイベントのタイプを表示します。前項の通り、ERR / WRN / INFOの 3種類

のイベント・タイプが存在します。 

Code 発生したイベントのイベント・コードが表示されます。 

Message イベントに対する詳細説明が表示されます。 

 

7.4.4. イベントの保存 

④を押下すると、現在③に表示されている全てのイベントを、CSVファイルへ保存するためのダイアログ

が表示されます。必要に応じて CSV ファイルへ保存し、イベント・データの解析にご利用頂く事が可能で

す。 

 

7.5. カメラ・イベントの取得/表示 

カメラから取得したイベントを表示します。ツールバーの[View] → [Camera Control] → [Camera Event]

を選択する事により、当該ペインを開く事が可能です。 

 

 

 

 

 

 

 

 

 

 

 

 

 

7.5.1. カメラ・イベント・リストの消去 

①を押下すると、イベント・リストに表示されている全てのイベントが消去されます。 

① ② ③ ④ ⑤ 

⑥ 
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7.5.2. カメラ・イベントの ON/OFF 切り換え 

②を押下する事により、カメラ・イベントの ON/OFFを切り換えます。ボタンは押下される度に下記の何

れかの状態に切り替わります。 

状態 効果 

ボタン カメラ・イベントの通知が OFFの状態です。このボタンを押下する

と、通知が ONに切り替わり、ボタン表示は下記の状態となります。 

ボタン カメラ・イベントの通知が ON の状態です。このボタンを押下する

と、通知が OFFに切り替わり、ボタン表示は上記の状態となります。 

 

7.5.3. カメラ・イベントの選択 

③を押下すると、下図の「Select Event」ダイアログが表示されます。ここで取得するイベントを選択し

ます。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

TeliViewer 上で現在選択中のカメラで、利用可能なイベントがチェックボックス形式で表示されます。こ

こでチェックしたイベントが有効化されます。 

 

 

選択可能なイベントについて 

選択可能なイベントは、ご利用中のカメラにより異なります。カメラが通知

可能なイベントの詳細については、ご利用頂いているカメラの取扱説明書を

ご覧下さい。取扱説明書は、弊社ホームページよりダウンロードする事が

可能です。 

 

 

複数のイベントを同時に選択

した場合 

単位時間当たりに受信されるイベント数が増大する事により CPU 負荷が上

昇します。その結果、キャプチャー・レート、あるいはディスプレイ・レー

トが低下する場合があります。この様な状況を避けたい場合、必要最小限の

イベントを有効化してご利用下さい。 

 

 

ヒント 

注意 

https://www.toshiba-teli.co.jp/
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7.5.4. 取得したカメラ・イベントの保存 

④を押下すると、現在⑥に表示されている全てのイベントを、CSVファイルへ保存するためのダイアログ

が表示されます。必要に応じて CSV ファイルへ保存し、イベント・データの解析にご利用頂く事が可能で

す。 

 

7.5.5. オプション設定 

⑤を押下すると、下図の「Event Display options」ダイアログが表示されます。ここでは、⑥に表示され

るイベントの表示設定を行う事が可能です。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 項目 説明 

① Update interval of list 
画面の更新間隔をミリ秒単位で指定します。100～3000 ミリ秒の間で設定する

事が可能です。デフォルトは、500ミリ秒です。 

② Maximum events in list 
リストに表示されるイベントの最大件数を指定します。10～1000件の間で設定

する事が可能です。デフォルトは、200件です。 

③ Event display format 

イベントの表示形式を選択します。下記の何れかから選択します。 

➢ Code 

イベント・コードのみを表示します。 

➢ String 

イベント名称の文字列を表示します。 

➢ String + Code 

イベント名称の文字列とイベント・コードを同時に表示します。 

④ Timestamp display format 

Timestampの表示形式を選択します。下記の何れかから選択します。 

➢ Hexadecimal 

16進数で表示します。 

➢ Decimal 

10進数で表示します。 

 

 

①と②の設定について 

①の設定値を小さくした場合、また、②の設定値を大きくした場合、共にリ

スト更新処理による CPU負荷が上昇します。その結果、キャプチャー・レー

ト、あるいはディスプレイ・レートが低下する場合がありますのでご注意下

さい。 

① 

② 

③ 

④ 

注意 
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7.5.6. カメラ・イベント・リスト 

⑥にカメラから取得したイベントが、受信した順に表示されます。1 行で 1 イベント分の情報が表示され

ます。イベントは、下記のフォーマットで表示されます。 

 

[イベント取得日時], [カメラ識別情報], [イベント], [Timestamp] 

 

項目 説明 

イベント取得日時 イベントを取得した、ホスト端末側の日付、時間を示します。 

カメラ識別情報 
イベントを送信したカメラを識別するための情報を示します。ModelName + 

SerialNumber + DeviceUserIDで構成されます。 

イベント 
カメラから取得したイベントを示します。「オプション設定」の③で指定した形式で表

示されます。 

Timestamp 
カメラから送信された Timestamp 情報を示します。「オプション設定」の④により、

表示形式を 10進数/16進数の何れかから選択する事が可能です。 

 

7.6. カメラ・コントロール・ペイン 

TeliViewer は、使用される頻度の高い機能へ、より容易にアクセスする事が可能なようにカメラ・コント

ロール・ペインを実装しています。 

このペインについて、使い方や推奨事項等を説明します。 

 

7.6.1. ペインの種類 

下表のようなペインが実装されています。 

ペイン名称 効果 

Image Format 
PixelFormat、Width/Height等、画像のフォーマットに関する調整を行うための機能が

サポートされています。 

Image Correction 
Gain、Gamma、あるいは WhiteBalance等、画像の画質に関する調整を行うための機

能がサポートされています。 

Color Masking 
カラー・マスク調整を行うための機能がサポートされています。 

※Color Masking機能をサポートするカラーカメラでのみ、ご利用頂く事が可能です 

Exposure 露光調整を行うための機能がサポートされています。 

Acquisition 画像取得制御を行うための機能がサポートされています。 

Trigger トリガ制御を行うための機能がサポートされています。 

UserSet 
カメラ上のユーザー設定データの保存/復元を行うための機能がサポートされていま

す。 

GEV Setting GigEカメラ固有の設定を行うための機能がサポートされています。 

U3V Info USB3カメラ固有の情報を表示します。 

Register R/W カメラ・レジスタの Read/Write を実行できます。 
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7.6.2. 機能説明の表示 

各機能のラベル部分へマウス・カーソルを移動させると、その機能のツール・チップが表示されます。機

能に対する概略の説明が表示されますので、ご利用する上での参考として下さい。 

下図は、Gainのラベルへカーソルを移動させ、ツール・チップが表示された場合の例です。 

 

 

 

 

 

 

各機能の詳細な情報を確認し

たい場合 

カメラ・コントロール・ペインでサポートされている各機能について、

より詳細な情報が必要な場合は、ご利用頂いているカメラの取扱説明書

をご覧下さい。取扱説明書は、弊社ホームページよりダウンロードす

る事が可能です。 

 

7.6.3. 設定可能な値の範囲の表示 

各機能のスライダーあるいはエディットボックスへカーソルを移動させると、Min/Max/Inc が表示されま

すので、値を設定するときの参考として下さい。 

下図は、Widthのスライダーへカーソルを移動したときの表示内容です。設定可能な値の最小値が 64、最

大値が 2048、増加量が 4である事を意味しています。 

 

 

 

 

 

 

 

Incの表示について 
Incは、機能によってはサポートされていない場合があります。その場合、Incは

表示されません。 

 

7.6.4. 更新ボタンの利用 

カメラ・コントロール・ペインのツールバー上には、下図のボタンが配置されています。これらについて

説明します。 

 

 

 

 

7.6.4.1. 更新ボタン 

①を押下すると、現在のペイン内の各機能の値が更新されます。 

例えば、FeatureView 内から機能の設定値を変更した場合、仮にカメラ・コントロール・ペインに実装さ

れている機能へ影響がある場合でも、ここへは現在の値が自動的には反映されません。その場合、①を押下

し、最新の値を再読み込みして下さい。 

 

ヒント 

注意 

① ② 
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7.6.4.2. 自動更新ボタン 

②は Image Correction、Exposureペインでのみ利用可能です。これを押下すると、定期的にペイン内の機

能の現在の値を、自動的に再読み込みします。 

Gain や WhiteBalance、あるいは ExposureTime 等の、自立的に値が変更される値を自動的に捕捉したい

場合にご利用下さい。 

更新間隔は 1000ミリ秒です。また、再度押下すると自動更新は OFFになります。 

 

7.6.5. グレイアウトしている項目について 

ペイン内の機能がグレイアウトして使用できない場合、下記の何れかの状態である事を示します。 

 

➢ 現在のカメラ状態では設定不可 

ストリーミング中には設定を変更できない項目が存在します(例えば、PixelFormat、Width、Height

等)。これらはストリーミングをストップする事により、設定を変更する事が可能となります。 

これに該当する場合、ストリームを「ストップ」する事により、設定が可能となります。 

 

➢ 他の設定項目との依存関係により設定不可 

他の項目の設定状態により、現在の項目がグレイアウトされる場合があります。例えば、

AcquisitionFrameRate 項目は、AcquisitionFrameRateControl 項目を“Manual”設定にする事で有効に

なります。AcquisitionFrameRateControlがこれ以外に設定されている場合は、グレイアウトされた状態

となります。 

 

➢ 現在のカメラでサポートされていない 

現在ご利用中のカメラで、その機能がサポートされていない場合、項目はグレイアウトされます。 

 

 

ご利用中のカメラがサポート

している機能を確認したい場

合 

ご利用中のカメラがサポートする機能の詳細について情報が必要な場

合は、カメラの取扱説明書をご覧下さい。取扱説明書は、弊社ホーム

ページよりダウンロードする事が可能です。 

 

ヒント 
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7.6.6. 推奨される使用方法 

TeliViewerに実装されている各ペインは、下図のように複数段化/タブ化して使用する事ができます。ペイ

ンをドラッグ・アンド・ドロップする事により、よく使う機能をアクセスしやすいお好みの構成に変更して

ご利用下さい。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

複数段化 

タブ化 
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7.7. マルチキャスト 

ここで説明するマルチキャスト機能は、GigE カメラでのみご利用頂く事が可能です。 

この機能を利用する事により、ひとつの GigEカメラからの画像を複数のホスト端末上でストリーミングす

る事が可能です。 

 

7.7.1. 概要 

マルチキャストをご利用頂く上での概要について説明します。下図は、マルチキャストを利用するための

一般的な構成を示しています。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 機器 説明 

① GigEカメラ マルチキャストを使用し、画像を配信する GigEカメラです。 

② 分配器 

一般的に、スイッチあるいはルータと呼ばれる機器です。この機器は、IGMP(Internet 

Group Management Protocol)をサポートする L3スイッチ、ルータ、あるいは IGMP 

Querier機能をサポートする L2スイッチ等、マルチキャスト配信に対応した機器であ

る必要があります。 

③ コントローラー端末 

カメラへ RW権限でアクセスし、カメラの制御と画像の受信を行うホスト端末です。

下記の文中では、これをコントローラー端末と呼称します。ひとつのマルチキャス

ト・グループ内でコントローラー端末となれるのは、ひとつの端末のみです。 

④ リスナー端末 

カメラへRO権限でアクセスし、カメラからの画像の受信のみを行うホスト端末です。

下記の文中では、これをリスナー端末と呼称します。上図のように、複数のリスナー

端末をマルチキャスト・グループ内に存在させる事が可能です。 

 

 

 

各機器の IPアドレス設定について 

上図内の各機器に対し、通信可能な IPv4 アドレスおよび、サブネットマスクが

適切に設定されている必要があります。IPアドレスの割り振りなどについては、

ご利用中のネットワークの管理者にご確認の上、設定を行って下さい。 

 

① 
② ③ 

④ 

④ 

注意 
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7.7.2. Access modeの設定 

各ホスト端末の Access Modeが下表のように設定されている必要があります。なお、Access modeはカ

メラをオープン時に、TeliViewer により自動的に決定されますので、基本的にはユーザーが特に設定を変更

する必要はありません。 

ホスト端末 Access Mode 補足 

コントローラー端末 Control RW権限でのアクセスを行います。 

リスナー端末 Monitor RO権限でのアクセスを行います。 

 

例えば、コントローラー端末が既にGigEカメラをオープンしている場合、2台目以降の端末から同じGigE

カメラをオープンしようとした場合、リスナー端末からのオープンであると判断し、自動的に Access mode

に Monitorアクセスを選択してオープンされます。 

例外として、コントローラー端末よりも前に、リスナー端末が GigEカメラを開く場合は、Access mode

へ明示的に Monitorアクセスを選択する必要があります。選択の変更を行う場合は、こちらの「Access mode

の選択」をご確認下さい。 

 

7.7.3. 設定項目の説明 

メニューバーより、[View] → [Camera Control] → [GEV Setting]を選択すると、下図のペインが表示され

ます。ここでマルチキャスト配信の設定を行います。各設定項目について説明します。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

① 

② 

③ 

④ 

⑤ 
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 項目 説明 

① MaxPacketSize 

マルチキャストを利用して配信を行う画像のパケットサイズを設定します。ここに設定

する値は、マルチキャスト・グループ内の全ての端末で同じ値を設定する必要がありま

す。詳細は次項の設定手順内の「MaxPacketSizeの決定」をご確認下さい。 

② Access Mode 
現在選択されている Access Mode が表示されます。コントローラー端末上で

は”Control”、リスナー端末上では”Monitor”が表示されます。 

③ Enable multicast これをチェックする事により、マルチキャストが有効になります。 

④ Address 

マルチキャストに使用する IPアドレスを設定します。デフォルトは、224.64.16.1です。 

マルチキャスト・グループ内の全ての端末で同じ値を設定する必要があります。 

この設定を変更する場合、規定により定められた IPv4 マルチキャストアドレスを使用

する必要があります。規定の詳細については RFCドキュメント等をご確認下さい。 

⑤ Port 

マルチキャストに使用する配信先ポート番号を設定します。デフォルトは、50506です。 

マルチキャスト・グループ内の全ての端末で同じ値を設定する必要があります。 

この設定を変更する場合、システムポート(あるいは Well Known Ports)として予約され

ているポート番号はご利用できません。ご利用可能なポート番号の詳細については、

IANAのホームページ等をご確認下さい。 

 

7.7.4. 設定手順の説明 

マルチキャストで配信を行うための、具体的な設定手順を説明します。 

 

7.7.4.1. MaxPacketSizeの決定 

全てのホスト端末で使用可能な MaxPacketSize を決定します。使用するべき MaxPacketSize の値は、マ

ルチキャストを利用して配信を行うグループの構成により異なります。これを決定するためには、マルチキ

ャスト・グループ内の全てのホスト端末の JumboPacket、あるいは MTU(Maximum Transmission Unit)のサ

イズを確認する必要があります。 

 

 

JumboPacket あるいは MTU サ

イズの確認/設定方法について 

Windows の場合、デバイスマネージャーよりネットワークアダプターの

プロパティを開く事によって JumboPacket 設定を操作する事が可能で

す。Linux 系 OS の場合、ifconfig 等で MTU 設定を操作する事が可能で

す。詳細については OSの取扱説明書をご覧頂くか、ご利用中のネット

ワークの管理者にご確認下さい。 

 

調査を行った結果、仮に、マルチキャスト・グループが下記のホスト端末で構成され、それぞれの

JumboPacket、あるいは MTUサイズが下表の通りだったとします。 

ホスト端末 JumboPacket / MTUサイズ 

コントローラー端末 9014 

リスナー端末 (A) 8192 

リスナー端末 (B) 4096 

MaxPacketSizeへは、「全てのホスト端末が受信可能な最大サイズ」を選択します。 

つまり上の例では、MaxPacketSize は 4096 が最適値となります。この値をこの後の設定手順で使用しま

す。 

最適な MaxPacketSize 

4096 

ヒント 
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7.7.4.2. コントローラー端末の設定 

先にコントローラー端末の設定を行ってから、リスナー端末の設定を行う事を推奨します。 

コントローラー端末の設定手順は下記の通りです。 

 

 

 

 

 

 

 

 

 

 

 

 

 

7.7.4.3. リスナー端末の設定 

リスナー端末の設定を行う前に、コントローラー端末の設定を完了しておく事を推奨します。 

リスナー端末の設定手順は下記の通りです。 

 

 

 

 

 

 

 

 

 

 

 

 

【手順】 

1) コントローラーとなる端末上で TeliViewerを起動します。 

2) 「カメラのオープン」手順に従い、GigEカメラをオープンします。 

3) 「GEV Settingペイン」を開きます。この時、Access Modeの項目が”Control”である事を確認しま

す。 

4) Enable multicastをチェックします。 

5) Addressと Portの項目を変更する場合は、新しい値を設定します。特に変更する必要がない場合は

デフォルト設定の状態で、ご利用する事が可能です。 

6) MaxPacketSizeへ「決定した値」を設定します。 

7) 「ストリーム操作」手順に従い、ストリームをスタートします。 

8) カメラから取得した画像が、正しく表示されている事を確認します。 

【手順】 

1) リスナーとなる端末上で TeliViewerを起動します。 

2) 「カメラのオープン」手順に従い、GigEカメラをオープンします。 

3) 「GEV Settingペイン」を開きます。この時、Access Modeの項目が”Monitor”である事を確認しま

す。 

4) Enable multicastをチェックします。 

5) Addressと Portへ、コントローラー端末と同じ値を設定します。 

6) MaxPacketSizeへ、コントローラー端末と同じ値を設定します。 

7) 「ストリーム操作」手順に従い、ストリームをスタートします。 

8) カメラから取得した画像が、正しく表示されている事を確認します。 
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7.8. Waveform 

波形モニターを表示します。現在表示中の画像の、輝度特性を確認する事ができます。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

各項目の意味は下記の通りです。 

 項目 説明 

① モニター 現在の波形を表示します。 

② 色諧調の指定 モニターする色の諧調を指定します。0～255を指定する事ができます。 

③ モニター範囲の指定 
モニターする範囲を指定します。 

指定可能な範囲は、⑤および現在のカメラの Widthまたは Height設定に依存します。 

④ ポーズ・ボタン このボタンを押下する事により、モニターの更新を一時停止する事ができます。 

⑤ 方向設定 水平方向、または垂直方向のどちらかを選択します。 

⑥ 表示データ選択 
YUV、あるいは RGBのどちらかを選択します。また、それぞれの成分の表示/非表示を

チェックボックスにより選択する事が可能です。 

⑦ サンプリング領域 
Areaボタンを押下する事により、領域指定モードに移行します。このモード下では、サ

ンプリング領域を限定する事ができます。 

⑧ 線の描画 モニター上へ、最大 3本の線を描画する事が可能です。 

⑨ 強度設定 各要素の、表示上の強度設定を変更する事が可能です。 

 

 

 

モニターの更新間隔を変更した

い場合 

更新間隔を変更したい場合、オプション設定の「Updating interval of 

charts」から変更する事が可能です。 

 

ヒント 

② 

② 

③ ③ 
④ 

⑤ ⑥ 

⑦ 

⑧ 

⑨ 

① 

https://www.toshiba-teli.co.jp/


 

. 

 

 

50 

Copyright © 2021 - 2023 Toshiba Teli Corporation, All rights reserved.  https://www.toshiba-teli.co.jp/ 

 

DAA02812C 

 

7.9. Vectorscope 

ベクトルスコープを表示します。現在表示中の画像の色相、彩度を確認する事ができます。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

各項目の意味は下記の通りです。 

 項目 説明 

① スコープ 現在のベクトル特性を表示します。 

② 値表示 スコープ上のマウス・カーソル位置の値を表示します。 

③ ポーズ・ボタン このボタンを押下する事により、スコープの更新を一時停止する事ができます。 

④ 強度設定 各要素の、表示上の強度設定を変更する事が可能です。 

⑤ 倍率設定 表示倍率を変更する事が可能です。 

 

 

 

スコープの更新間隔を変更した

い場合 

更新間隔を変更したい場合、オプション設定の「Updating interval of 

charts」から変更する事が可能です。 

 

① 

② 

③ 

④ 

⑤ 
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7.10. Histogram 

ヒストグラムを表示します。現在表示中の画像の、画素値分布を確認する事ができます。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

各項目の意味は下記の通りです。 

 項目 説明 

① ヒストグラム 
現在の画素値の分布をチャートとして示します。①上でマウス・カーソルを移動すると、

⑥で選択した各データ要素の度数が、ツール・チップとして表示されます。 

② 度数 (Y軸) 
⑥で選択した各データ要素に対し、各画素値の出現度数を示します。Y 軸の最大値は、

現在の画像に応じて動的に変化します。 

③ 画素値 (X軸) 

画素値を示します。画素値の最大値/最小値は、現在の画像フォーマットに依存します。

上図は RGBフォーマットを選択した場合の例で、0～255の値を表示しています。 

また、X 軸上にマウス・カーソルがある場合、Ctrl キーを押下しながらマウス・ホ

イールを Up/Downする事により部分的な拡大表示が可能です。 

④ 拡大のリセット 
③で X軸が拡大状態にある場合に有効になります。このボタンを押下すると拡大がリセ

ットされ、標準スケールの状態に戻ります。 

⑤ 統計情報 
⑥で、ひとつの要素を選択した場合にのみ有効になります。現在選択中のデータ要素に

対し、平均/標準偏差/最大/最小の各値について表示を行います。 

⑥ データ要素選択 

ヒストグラムとして表示を行いたいデータ要素を選択します。現在の画像がモノクロの

場合、Y のみが選択可能です。カラー画像の場合、全てのデータ要素が選択可能です。

上図は、カラー画像上で R、G、Bを選択した場合の例です。 

 

 

 

チャートの更新間隔を変更した

い場合 

更新間隔を変更したい場合、オプション設定の「Updating interval of 

charts」から変更する事が可能です。 

 

ヒント 

① 

② 

③ 

⑤ ④ 

⑥ 

https://www.toshiba-teli.co.jp/
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7.11. カメラ設定の保存/復元 

ツールバー上の下記のボタンを操作する事により、カメラ設定の保存あるいは復元を行う事ができます。 

 

 

これは FeatureViewに実装された機能へのショートカットです。操作方法については FeatureViewの、「カ

メラ設定の保存/復元」の説明に記載されている内容と同じですのでご確認下さい。 

 

 

7.12. 動画保存機能 

ストリーミング中の画像を動画として、AVIあるいは MP4形式のファイルへ保存する事が可能です。 

 

 

利用可能なプラットフォームにつ

いて 

当機能は、ラズベリーパイ等の ARM アーキテクチャが採用されているプラット

フォーム上では、ご利用頂く事ができません。 

 

7.12.1. ご利用頂く上での注意事項 

下記の内容について十分なご理解と、ご同意を頂きました上で、当機能をご利用下さい。 

 

1) 動画保存機能について 

TeliViewerは、動画保存機能に GStreamerを利用します。ユーザーは、GStreamerをご自身の環境へ導入

する事により動画保存機能を利用する事が可能です。 

 

2) 動画の保存について 

ユーザーは、TeliViewer 上で動画を保存する際に、非圧縮(デフォルト)/圧縮のいずれかを選択する事が可

能です。動画を圧縮して保存したい場合、エンコーダーを利用する事により実現が可能です。 

 

3) エンコーダーの導入について 

ユーザーは、GStreamer Pluginを導入する事により、TeliViewer上での動画保存にエンコーダーを利用す

る事が可能です。 

 

4) エンコーダーの選択について 

各エンコーダーには、個々のライセンスが存在し、特許技術が含まれる場合もあります。ユーザーは、ご

自身の責任において利用するエンコーダーを選択し、選択したエンコーダーの利用条件に同意する必要があ

ります。 

 

5) H.264 エンコーダーを選択する場合 

動画の圧縮に H.264規格に準ずる技術を利用する場合、下記の条項に同意する必要があります。 

https://www.mpegla.com/wp-content/uploads/avcweb.pdf 

[補足] 

“Where End User pays for AVC Video”条項等、詳細については、ドキュメント内に記載されている、

ユーザーが該当する利用条件をご確認下さい。 

 

6) エンコーダーの動作について 

このドキュメントは、TeliViewer 上でエンコーダーを利用するための参考手順を説明する物であり、弊社

がエンコーダーの動作を保証するものではありません。 

注意 

https://www.toshiba-teli.co.jp/
https://www.mpegla.com/wp-content/uploads/avcweb.pdf
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7) 利用手順について 

下記に示す内容は、当ドキュメント作成時の参考手順であり、URLに関する情報やインストール手順等は、

モジュール配布元の都合により変更される場合があります。下記の利用手順内に現状とそぐわない箇所があ

ったとしても、インターネット検索等を利用する事により、ユーザーご自身で解決して頂く必要があります。 

 

8) 免責事項 

➢ 弊社は、エンコーダーを使用した事により発生した不具合等について、一切の責任を負いません。エ

ンコーダー使用時に発生する不具合等については、エンコーダーの配布元にお問い合わせ下さい。 

➢ 弊社は、上記 4) の選択により発生したライセンスや特許問題等について、一切関知致しません。 

➢ 弊社は、ユーザーからのエンコーダーに関する質問には、回答する事ができません。 

 

7.12.2. GStreamer の導入 

当機能をご利用頂くには、下記の手順により GStreamerをご利用中の環境へ導入する必要があります。 

 

7.12.2.1. Windows の場合 

Windows 環境上でご利用頂くには、下記の手順に従い、GStreamer パッケージのダウンロード、インス

トール、および、パスを適切に設定する必要があります。 

当マニュアルの説明内に不明な点がある場合、下記のリンク先の内容についても合わせてご確認下さい。 

[GStreamer: Installing on Windows] 

https://gstreamer.freedesktop.org/documentation/installing/on-windows.html?gi-language=c 

 

7.12.2.1.1. GStreamer パッケージのダウンロード 

下記のリンクより、ご利用中の環境に合致した「runtime installer」をダウンロードします。 

https://gstreamer.freedesktop.org/download/ 

 

7.12.2.1.2. GStreamer パッケージのインストール 

ダウンロードしたインストーラを起動し、GStreamer をインストールします。インストール・オプション

の選択により、インストールされる Plugin の構成が異なります。詳細については、GStreamer の取扱説明

書等によりご確認下さい。 

 

7.12.2.1.3. パスの設定 

GStreamerをインストール後、TeliViewerから利用可能とするためには、パスの設定を行う必要がありま

す。下記の手順を参考に、パスの設定を実施して下さい。 

下記の手順では、デフォルトのインストール先フォルダ「C:¥gstreamer」へ、インストールを行った場合

を例として記述しています。デフォルトのインストール先以外の場所へインストールを行った場合、下記の

手順内に記載されているものと異なるフォルダをパスとして設定する必要がありますので、ご注意下さい。 

 

【手順】 

1) Windowsのスタート・ボタンを右クリックします。 

2) 表示されるメニューの中から、[システム]を選択します。 

3) 開かれたウィンドウを下方へスクロールし、[システムの詳細設定]を選択します。 

4) 詳細設定タブを選択し、[環境変数]ボタンを押下します。 

https://www.toshiba-teli.co.jp/
https://gstreamer.freedesktop.org/documentation/installing/on-windows.html?gi-language=c
https://gstreamer.freedesktop.org/download/
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5) 下図のダイアログが表示されますので、[Path]の行を選択し、[編集]ボタンを押下します。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

6) 下図のダイアログが表示されますので、「新規」ボタンを押下します。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

7) パスの入力モードになりますので、下図のように「C:¥gstreamer¥1.0¥msvc_x86_64¥bin」を設定後、

OKボタンを押下し、保存します。インストール手順でインストール先をデフォルトとは異なる他の

フォルダに変更した場合は、「%インストール先フォルダ%¥1.0¥msvc_x86_64¥bin」を設定します。 

https://www.toshiba-teli.co.jp/
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8) 以上でパスの設定作業は完了です。OKボタンを押下し、設定画面を閉じます。 

9) システム全体に変更を反映するために、Windowsを再起動します。 

 

7.12.2.2. Linux 系 OSの場合 

下記のリンク先の内容をご確認下さい。 

[GStreamer: Installing on Linux] 

https://gstreamer.freedesktop.org/documentation/installing/on-linux.html?gi-language=c 

 

7.12.3. 動画保存の設定 

1) 動画を保存するカメラを Openします。 

2) 下図のように、Menu Barから[Recording] → [Settings]を選択します。 

 

 

 

https://www.toshiba-teli.co.jp/
https://gstreamer.freedesktop.org/documentation/installing/on-linux.html?gi-language=c
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3) その結果、下図のダイアログが開きます。ここで保存する動画ファイルの設定を行います。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

7.12.3.1. File path 

①により、動画ファイルの保存先を選択します。デフォルトの保存先は下記の通りです。 

OS 保存先 

Windows %HOMEPATH%Videos 

Linux系 OS $HOME/Videos 

 

 

 

動画保存先の記憶媒体の選択

について 

動画保存機能は、保存先として選択された記憶媒体がサポートする書き

込み速度の影響を受けます。記憶媒体への書き込み可能速度が低速であ

った場合、書き込み時のコマ落ち等の問題が発生する原因となります。

より再現性の高い、高品質な動画の保存を望まれる場合、M.2 や SSD

等の高速な書き込みが可能な記憶媒体を、動画保存先として選択する事

が推奨されます。 

 

7.12.3.2. File name 

②により、動画を保存するファイル名を指定します。デフォルト状態では「Video_yymmdd_hhmmss」が

選択されています。 

(yymmdd: 動画保存ボタンを押下した時点の年月日、hhmmss: 動画保存ボタンを押下した時点の時分秒) 

これ以外のファイル名を指定したい場合、チェックをはずし、エディットボックスへ保存したいファイル名

を入力します。 

 

7.12.3.3. File format 

保存するファイルのフォーマットを選択します。下記の何れかから選択する事が可能です。利用する再生

方式に応じて、最適なフォーマットを選択して下さい。 

ヒント 

① 

② 

③ 

④ 

⑤ 

⑥ 

⑦ 

https://www.toshiba-teli.co.jp/
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また、非圧縮形式での動画保存を選択した場合、自動的に MP4が選択されます。 

フォーマット 説明 

AVI AVI形式で動画を保存します。 

MP4 MP4形式で動画を保存します。 

 

7.12.3.4. Use encorder 

④をチェックする事により、現在の環境で利用可能なエンコーダーがリストに表示されます。TeliViewer

では、GStreamer をインストールした時に同時にインストールされる、いくつかのエンコーダーを利用する

事が可能です。ドロップダウン・リストからエンコーダーを選択する事により、圧縮形式で動画を保存する

事が可能です。 

④をチェックしない場合、動画は非圧縮形式で保存されます。デフォルトは非圧縮です。 

 

 

ドロップダウン・リストに表示

されるエンコーダーについて 

ここで選択可能なエンコーダーは、現在ご利用中の OS、ディストリビ

ューション、あるいは GStreamer をインストールした時のインストー

ル・オプションの指定等により変化します。選択可能な個々のエンコー

ダーに関する情報が必要な場合、インターネット検索等を利用する事に

よりご確認下さい。 

また、ご利用中の環境によっては、ハードウェア・エンコーダーを使用

可能な場合があります。その場合、ハードウェア・エンコーダーを選択

する事により、低負荷な動画保存を実現できる見込みが高くなります。 

 

7.12.3.4.1. Threads設定 

④をチェックし、エンコーダーを選択した結果、選択中のエンコーダーが圧縮に使用するスレッド数を変

更可能な場合、このメニューが有効になります。使用するスレッド数を増加させると、圧縮にかかる時間が

短縮されますが、CPU 使用率が上昇します。減少させた場合、圧縮にかかる時間が長くなりますが、CPU

使用率は減少します。 

 

7.12.3.5. Limit Max video frame rate 

⑤を有効化する事により、動画ファイルへ保存する最大フレームレートを制限する事が可能です。動画フ

ァイルの肥大化を回避したい場合等にご利用頂く事で、回避策として有効に作用します。 

設定可能な値の範囲は、現在のカメラの”AcquisitionFrameRate”の設定に依存します。 

 

7.12.3.6. Limit Max frame to save 

⑥を有効化する事により、動画ファイルへ保存する最大フレーム数を制限する事が可能です。際限無く動

画保存を継続する事なく、特定のフレーム数の保存が完了した時点で動画保存を終了したい場合等にご利用

下さい。 

 

7.12.3.7. Optimization for uncompressed video 

④をチェックしない場合、動画は非圧縮 (Uncompressed) 形式で保存されます。その時、⑦のメニューが

有効化され、次の何れかから設定を選択する事が可能です。 

ヒント 

https://www.toshiba-teli.co.jp/
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設定 説明 

Scale down FPS 
動画ファイルへ画像を書き込むときのフレームレートを最適化

(自動的なフレームの間引き)し、保存を行います。 

Scale down image size 
動画ファイルへ画像を書き込むときの画像サイズを最適化(自動

的な縮小化)し、保存を行います。 

 

 

 

非圧縮形式での動画保存につ

いて 

カメラから受信した画像データを非圧縮形式で動画として保存する場

合、一般的には、エンコードされた動画と比較して大容量化します。保

存先メディアの書き込み速度にも依存しますが、多くの場合、容量過多

が原因となり、コマ落ち等の問題が発生し、望まれる動画保存結果を得

る事ができない可能性が高くなります。この対策として、TeliViewer は

非圧縮形式での動画保存を選択された場合、ここで選択された何れかの

オプションを使用し、メディアへの書き込み速度を 150MB/sec 程度に

最適化して保存を行います。この結果、保存された動画のスムーズな再

生結果を得る事が可能となっています。 

 

7.12.4. 動画の保存 

TeliViewer上のツールバーから操作を行う事により、動画保存の開始/停止を操作します。 

 

7.12.4.1. 保存の開始 

1) Streamをスタートします。 

2) ツールバー上に配置された下図のボタンを押下します。 

 

3) 動画の保存が開始されますので、必要な保存時間まで待ちます。 

 

7.12.4.2. 保存の停止 

1) ツールバー上に配置された下図のボタンを押下します。 

 

2) 動画の保存が終了し、「File path」で指定したフォルダへ、「File name」で指定したファイルが保存されま

す。 

 

ヒント 
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7.13. ツール 

メニューバーより[Tools]を選択すると、次のような機能を利用する事が可能です。これらにより、

TeliViewerをご利用頂く上での各種設定を変更する事ができます。 

 

7.13.1. IP Configuration Tool の起動 

メニューバーの[Tools] → [IP Configuration Tool]を選択すると、外部ツール「IP Configuration tool」を起動

する事が可能です。これをご利用頂く事により、ネットワーク上に存在する GigEカメラに対して IPアドレ

ス設定を変更する事が可能です。 

 

7.13.2. オプション設定 

メニューバーの[Tools] → [Options]を選択すると下図のダイアログが表示されます。これにより TeliViewer

に対する各種設定の変更を行う事ができます。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

① 

② 

③ 

④ 

⑤ 

⑥ 

⑦ 

⑧ 

⑨ 

⑩ 

⑪ 
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7.13.2.1. Updating interval of charts 

①により、Waveform、Vectorscope、Histogram といった TeliViewer に実装されているチャートの更新間隔

の設定を変更する事ができます。デフォルトは、2.00秒です。 

 

7.13.2.2. Save and restore Grid/4x4 settings 

②の Enable チェックボックスを ONする事により、現在の画像に描画されている線の状態を、保存/復元す

る事ができます。保存/復元は下記の処理手順で実行されますので、ご確認の上、ご利用下さい。この設定は、

デフォルトは OFFです。 

 

 

 

 

 

 

 

 

 

 

 

7.13.2.2.1. Save always when camera is closed 

この機能は、②の Enable チェックボックスが ON の時に有効になります。このチェックボックスを ON

に設定した場合、当該カメラがクローズされる時に毎回、現在の線の描画状態を自動的に保存あるいは更新

します。一度「Save now」ボタンにより保存したデータを繰り返し利用したいような場合は、このチェック

ボックスを OFFにしてご利用下さい。 

 

7.13.2.3. Save and restore camera streaming status 

③の Enable チェックボックスを ONする事により、現在のカメラのストリーミング状態を保存/復元する事

ができます。保存/復元は下記の処理手順で実行されますので、ご確認の上、ご利用下さい。この設定は、デフ

ォルトは OFFです。 

 

 

 

 

 

 

 

 

 

 

 

 

 

【手順】 

1) 現在ストリーミング中の画像へ「Grid」あるいは「4x4」の線を描画します。 

2) ②の Enableチェックボックスをチェックされた状態にします。 

3) 「Save now」ボタンを押下すると、TeliViewerは“線の設定データ”を保存します。この時、TeliViewer

は「モデル名/シリアルナンバー/DeviceUserID」を識別 IDとして保存します。 

4) 手順 3でクローズしたカメラをオープンします。この時、「モデル名/シリアルナンバー

/DeviceUserID」が一致する識別 IDを持つ“線の設定データ”が存在する場合、これを読み出しま

す。 

5) ストリーミングを開始すると、手順 1で描画されていた線の描画状態が復元されます。 

【手順】 

1) 現在オープン中のカメラのストリーミングを開始します。 

2) ②の Enableチェックボックスをチェックされた状態にします。 

3) 「Save now」ボタンを押下すると、TeliViewerは“ストリーミング状態の設定データ”を保存しま

す。この時、TeliViewerは「モデル名/シリアルナンバー/DeviceUserID」を識別 IDとして保存しま

す。 

4) TeliViewerを終了します。 

5) 次に TeliViewerを起動した時、「モデル名/シリアルナンバー/DeviceUserID」が一致するカメラが存

在し、かつ、同じ識別 IDを持つ“ストリーミング状態の設定データ”が存在する場合、当該カメラ

を自動的にオープンし、保存されているデータを読み出してカメラへ設定します。 

6) その結果、保存したストリーミング状態が復元されます。 

https://www.toshiba-teli.co.jp/
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7.13.2.3.1. Save always when TeliViewer is closed 

この機能は、③の Enable チェックボックスが ON の時に有効になります。このチェックボックスを ON

に設定した場合、TeliViewer がクローズされる時に毎回、現在のストリーミング状態を自動的に保存あるい

は更新します。 

つまり、TeliViewer を起動したときに、前回終了時の作業状態を毎回復元すると言った使い方をしたい場

合は、このチェックボックスを ONに設定します。 

一度「Save now」ボタンにより保存したデータを使用して、毎回同じ設定で起動したい場合は、このチェ

ックボックスを OFFに設定します。OFFに設定する事により、“ストリーミング状態の設定データ”が自動

的に上書きされる事はありません。 

 

7.13.2.4. Launch with full screen 

この機能は、③の Enable チェックボックスが ON の時に有効になります。④をチェックする事により、次

回起動時、TeliViewerはフル・スクリーンの状態で起動します。 

 

7.13.2.5. Hide exit button and cursor on full screen 

⑤をチェックする事により、フル・スクリーン画面上の右下に表示される「Exit ボタン」を非表示にする事

が可能です。また、同時にフル・スクリーン画面上のマウス・カーソルも非表示となります。 

この状態のとき、フル・スクリーン状態を終了するには ESCキーを押下します。 

 

7.13.2.6. Background Color 

画像の背景色を設定します。ブラックあるいはコバルトブルーの何れかから選択する事ができます。デフォ

ルトは、ブラックです。 

 

7.13.2.7. 2in1/4in1 setting 

⑦により、2in1/4in1画面のレイアウトを変更する事ができます。各設定の詳細は下記の通りです。 

 

7.13.2.7.1. Display TabBar 

カメラ識別情報、および現在の描画情報をタブ形式で表示します。表示イメージは下図の通りです。この

モードと Overlay the informationを同時に選択する事はできません。 

 

 

 

 

 

 

 

 

 

 

https://www.toshiba-teli.co.jp/


 

. 

 

 

62 

Copyright © 2021 - 2023 Toshiba Teli Corporation, All rights reserved.  https://www.toshiba-teli.co.jp/ 

 

DAA02812C 

 

7.13.2.7.2. Overlay the information 

カメラ識別情報、および現在の描画情報を画像へオーバーレイして表示します。表示イメージは下図の通り

です。このモードと Display TabBarを同時に選択する事はできません。 

 

 

 

 

 

 

 

 

 

 

 

 

ディスプレイ・レートへの影響に

ついて 

この機能は描画機能のパフォーマンスに影響を及ぼします。有効にすると、

「Display TabBar」を使用した場合と比較して、ディスプレイ・レートが若干

低下する場合がありますので、ご注意下さい。 

 

7.13.2.7.3. Display Scrollbar 

画像が表示領域をはみだしている時に、スクロール・バーを表示するかを選択します。 

設定を ONにした場合、下図のようにスクロール・バーが表示され、スクロール・バーを使用した画像のス

クロール操作が可能になります。 

設定を OFF に設定した場合は、画像が表示領域をはみだした場合でもスクロール・バーは表示されません

ので、表示領域がスクロール・バーにより狭くなる事がありません。また、スクロール・バーが表示されてい

ない状態でも「スクロール機能」を利用する事により画像のスクロールは可能です。 

お好みにより最適な設定を選択の上、ご利用下さい。 

 

 

 

 

 

 

 

 

 

 

 

 

Fitモード中のスクロール・バーに

ついて 

Fit モードで画像が表示されている場合は、スクロール・バーは表示されません

ので、ご注意下さい。 

 

スクロール・バー 

注意 

注意 
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7.13.2.8. Enable stream stats collection 

⑧をチェックする事により、ストリームの統計情報を収集し、表示する事が可能です。この機能は U3V カ

メラと GEVカメラでご利用が可能です。また、U3V/GEVのそれぞれの情報は、下記の手順により表示する事

が可能です。 

 

 

Stream stats の収集/表示について 
これらの収集および表示には、軽微ではありますが CPU リソースが消費されま

す。これらの情報が必要な時以外は、OFFの状態でご利用頂く事を推奨します。 

 

7.13.2.8.1. U3V の場合 

メニューバーより[View] → [Camera control] → [U3V Info] を開きます。U3V Infoのペインに「Stream stats」

が表示されます。 

 

7.13.2.8.2. GEV の場合 

メニューバーより[View] → [Camera control] → [GEV setting] を開きます。GEV settingのペインに「Stream 

stats」が表示されます。 

 

7.13.2.9. Enable GenTL devices 

この機能はユーザーサポートの目的で用意されているものです。通常は ONのままご利用下さい。 

⑨を操作し、この設定を OFF に設定すると、GenTL デバイスが TeliViewer 上で無効化されます。デフォル

トは ONです。 

 

 

OFFに設定した場合の注意点 CoaXPressカメラを使用する事ができなくなりますので、ご注意下さい。 

 

7.13.2.10. Maximum messages in Status Log 

⑩の値を操作する事で、「Status Log」に表示されるメッセージ数を変更する事が可能です。デフォルト値

は 50です。 

 

7.13.2.11. RestoreDefault 

⑪を押下する事により、TeliViewerの画面構成を推奨されるデフォルトの構成に戻す事が可能です。 

注意 

注意 
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7.14. ヘルプ 

メニューバーより[Help]を選択すると、次のような機能を利用する事が可能です。必要に応じてご利用下

さい。 

 

7.14.1. Open user manual 

メニューバーの[Help] → [Open user manual]を選択すると、当ドキュメント「TeliViewerユーザーマニュ

アル」を開く事が可能です。 

 

7.14.2. About 

メニューバーの[Help] → [About]を選択すると、バージョンナンバー等の、TeliViewerに関連する情報を確

認する事が可能です。 
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8. 補足事項等 
TeliViewerをご利用頂く上での、全般的な補足事項等について説明します。 

8.1. ペインの四隅への拡大 

ペイン上のボタンやリスト等が何もない領域を右クリックしたとき、ペインの拡大を行うためのコンテキス

ト・メニューが表示されます。表示される項目の種類は下記の 4種類です。これらはご利用可能な場合にのみ

表示されます。 

➢ Enlarge to left 

➢ Enlarge to right 

➢ Enlarge to top 

➢ Enlarge to bottom 

下記に、“Enlarge to right”を実施した場合の例を説明します。 

 

1)  下図の通り、現在の Status Log ペインは、ウィンドウの右下隅を占有していません。そのため、ペイン

の何も表示されていない領域を右クリックすると、“Enlarge to right”が表示されます。これを選択する

と、Status Logペインは右方向へ拡大します。 

 

 

 

 

 

 

 

 

 

 

 

 

 

2) その結果、下図のように Status Logペインが右下隅を占有するペイン配置となります。 

 

 

 

 

 

 

 

 

 

 

 

 

 

その他の“Enlarge to left”、“Enlarge to top”、“Enlarge to bottom”についてもほぼ同等の効果を得る事が

できます。最適なペイン配置およびペインサイズを得るために、上記手順を参考にしてご利用下さい。 

右方向へ、ペインを拡大 
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8.2. TeliViewer 終了時の状態保存/復元 

TeliViewer は、ユーザー操作により終了された場合、あるいは OS からのアプリケーション終了シグナル

を受信した場合に、現在のアプリケーション状態をファイル・システム上の設定ファイルへ自動的に保存し

ます。また、次回起動時に、保存された状態を復元します。 

ここで保存/復元の対象となるのは、TeliViewerの画面構成、あるいは FeatureViewや StatusLogのボタン

の押下状態等、アプリケーションに対する設定です。個々のカメラに対する設定は保存対象ではない事にご

注意下さい。 

個々のカメラに対する設定の保存/復元については、下記のヒントをご確認下さい。 

 

 

カメラ設定の保存/復元を行いた

い場合 
「カメラ設定の保存/復元」の説明をご確認下さい。 

Grid/4x4 設定の保存/復元を行い

たい場合 
「Save and restore Grid/4x4 settings」の説明をご確認下さい。 

TeliViewer の状態を初期状態へ

戻したい場合 

「RestoreDefault」を実行して下さい。これにより TeliViewer を初回インスト

ール時の状態へ戻す事が可能です。 

TeliViewer 設定の保存先につい

て 

[Windowsの場合] 

“%APPDATA%¥TOSHIBA TELI¥TeliCamSDK”フォルダ下の TeliViewer.iniフ

ァイルへ保存されます。 

[Linux系 OSの場合]  

“$HOME/.teliviewer”フォルダ下の TeliViewer.iniファイルへ保存されます。 

 

 

 

Raspberry Pi OSをご利用の場合 

Raspberry Pi OS 上では、TeliViewer が起動した状態で OSのシャットダウン処

理を実行した場合、アプリケーション状態が保存されません。これは Raspberry 

Pi OSからアプリケーション終了シグナルが通知されない事が原因です。 

Raspberry Pi OS上で確実に TeliViewer終了時の状態を保存するには、TeliViewer

をユーザー操作により終了させ、終了した事を確認後に OSのシャットダウンを

実行して下さい。 

[補足] 

Windows あるいは ubuntu OS上ではこのような問題は発生しません。TeliViewer

が起動した状態で OSのシャットダウンを実行した場合でも、状態は正しく保存

されます。 

注意 

ヒント 
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9. FAQ 
 

質問 回答 

画像にティアリングが発生します。 

ご利用のグラフィック・カードに対して最適なドライバがインストール

されていない場合、最適なパフォーマンスを得る事ができない場合があ

ります。また、ティアリング等の問題が発生する場合があります。最適

なドライバの入手方法については、各グラフィック・カードのベンダー

の、ホームページ等をご確認下さい。 

なお、ラズベリーパイ上では、グラフィック・カード性能の制約により、

ティアリングを回避する事ができません。 

ラズベリーパイ上でストリーミング

中にシステムのフリーズが発生しま

す。 

ラズベリーパイ上では、カメラからのストリーミング中に、フリーズ現

象が見られる場合があります。そのような現象が頻発する場合、

"Raspberry Pi OS"の代わりに"ubuntu MATE"を OSとしてご利用頂く事

をご検討下さい。 "ubuntu MATE"のご利用方法については、まず

"Raspberry Pi Imager"を使用し、ご利用されているラズベリーパイに最

適な ubuntu を、起動可能な SD カードへインストールする必要があり

ます(この操作により、SDカードの内容は全て消去される点にご注意下

さい)。次に、作成した SDカードイメージを使用して ubuntu を起動後、

端末から"sudo apt install ubuntu-mate-desktop"を実行します。再起動後

に、軽量デスクトップの"ubuntu MATE"が有効となり、フリーズ現象の

対策として効果を発揮する可能性があります。 

※ "Raspberry Pi Imager"と OS イメージ作成の詳細については、

Raspberry Pi OSのホームページをご確認下さい。 

TeliCamSDK パッケージをバージョ

ンアップ後、TeliViewer の画面構成

が意図しないものになりました。 

現在保存されているアプリケーション設定が、新しいバージョンにそぐ

わなくなっている可能性があります。「RestoreDefault」を実行して下さ

い。現在のバージョンに最適な構成で起動されます。 

仮想環境で複数カメラの同時再生が

正常に動作しません。 

ご利用中の環境が、ハードウェア要件とソフトウェア要件を満たしてい

る場合でも、仮想環境下では、十分な性能を得る事ができない可能性が

高いといえます(弊社内での動作確認結果による)。仮想環境におけるパ

フォーマンスに関する問題等、仮想環境に関するお問い合わせについて

は、各仮想環境の提供元へお問い合わせ下さい。 

複数カメラを同時にストリーミング

した時に、カメラのフレームレート

がカメラ性能を達成できません。 

OS あるいはディスプレイ・アダプタ・ドライバーに依存したボトルネ

ックにより、2in1/4in1モードでディスプレイ・レートが十分な性能を達

成できない場合があります。高パフォーマンスなディスプレイ・レート

を維持した 2in1/4in1 モードでのストリーミングを実施したい場合、ハ

ードウェア要件を満たした環境上で、Linux 系 OS(ubuntu 等) を選択す

る事を推奨致します。弊社内での検証結果からは、同一のハードウェア

上であれば、Linux 系 OS を使用した場合の方が他の OS を使用した場

合よりも、カメラ性能を十分に維持した高パフォーマンスなストリーミ

ングが実現されている傾向が見られます。 

複数カメラを同時にストリーミング

した時に、StatusLog にパケット・

ロストが表示されます。 

カメラから転送されるデータ量が、システム上の、データ・バスの転送

能力の限界を超えた場合、パケット・ロストが発生する場合があります。

たとえ CPU 性能が十分であったとしても、データ・バスの帯域が十分

に確保できていないと、パケット・ロストが発生する可能性があります。

複数カメラを同時にストリーミングしたい場合には、データ・バスの帯

域に十分な余裕があるかについてもご注意下さい。 

 

https://www.toshiba-teli.co.jp/


 

. 

 

 

68 

Copyright © 2021 - 2023 Toshiba Teli Corporation, All rights reserved.  https://www.toshiba-teli.co.jp/ 

 

DAA02812C 

ubuntu 22.04LTS 上で、フル・スク

リーン表示を行ったとき、ディスプ

レイ・レートが低下する場合があり

ます。 

ubuntu 22.04LTS で採用されているデフォルトのウィンドウシステム

は、GNOME Desktopが Waylandと共に選択されています。この環境下

で TeliViewerをフル・スクリーンで使用した場合、このような問題が見

られる事が確認されています。また、この問題は Xorg あるいは MATE 

Desktopをウィンドウシステムとして選択する事により、回避可能であ

る事も確認されています。もしこの問題に直面し、運用上の不都合があ

る場合、Xorg あるいは MATE Desktopをご利用頂く事をご検討下さい。 

ウィンドウシステムの切り換えは、グラフィカルログイン時にセッショ

ンリストを表示し、”Ubuntu on Xorg”あるいは”MATE”を選択する事によ

り切り替える事が可能です。なお、MATE Desktopは下記の手順により

導入する事で、選択可能となります。 

“sudo apt install ubuntu-mate-desktop” 

※ウィンドウシステム等に関する詳細については、ubuntuの取扱説明書

をご確認下さい。 

 

https://www.toshiba-teli.co.jp/


 

. 

 

 

69 

Copyright © 2021 - 2023 Toshiba Teli Corporation, All rights reserved.  https://www.toshiba-teli.co.jp/ 

 

DAA02812C 

 

10. その他 
 

10.1. 改定履歴 

Date Version Description 

2021/10/01 1.0.0 初版 

2022/07/25 1.0.1 下記の機能に対応。 

➢ Histogram 

➢ 4x4線のマウスによる移動 

➢ マルチキャスト 

➢ XMLファイルの Save/Load 

➢ 画像保存フォーマットの拡張 

BMP(8/24/32bpp)、PNG(8/16/24/32/48bpp)へ対応 

➢ IP Configuration toolの起動 

➢ ユーザーマニュアルの起動 

※その他、マイナーチェンジ内容の反映、誤記の修正等 

2023/02/28 1.0.2 マイナーチェンジ内容の反映、誤記の修正等 

2023/05/12 1.0.3 下記の機能に対応。 

➢ StatusLog 

- ログ保存機能 

➢ カメラ・イベントの取得/表示 

➢ 動画保存機能 

➢ オプション設定 

- Save and restore Grid/4x4 settings の改良 

- Save and restore camera streaming status 

- Launch with full screen 

- Hide exit button and cursor on full screen 

- Enable stream stats collection 

- Enable GenTL devices 

 

 

 

 

https://www.toshiba-teli.co.jp/


 

. 

 

 

70 

Copyright © 2021 - 2023 Toshiba Teli Corporation, All rights reserved.  https://www.toshiba-teli.co.jp/ 

 

DAA02812C 

10.2. 免責事項 

このソフトウェアの免責事項は、別途付属の”TeliCamSDK_License_Agreement_J.pdf” または ” License 

Agreement TeliCamSDK for Linux Jpn.txt”に記載されています。 必ずご一読の上、ご利用されますようお

願い致します。  

ライセンスに関するドキュメントは以下のフォルダにインストールされています。 

Windows版  ： [TeliCamSDK インストールフォルダ]¥Licenses  

Linux版  ： /opt/TeliCamSDK/licenses  

  

10.3. ライセンス 

TeliCamSDK は、複数の独立したソフトウェアコンポーネントを使用しています。 個々のソフトウェアコ

ンポーネントは、それぞれ第三者の著作権が存在します。 

 TeliCamSDK は、第三者が規定したエンドユーザーライセンスアグリーメントあるいは著作権通知（以下、

「EULA」といいます）に基づきフリーウェアとして配布されるソフトウェアコンポーネントを使用してお

ります。 

「EULA」の中には、実行形式のソフトウェアコンポーネントを配布する条件として、当該コンポーネント

のソースコードの入手を可能とするよう求めているものがあります。 当該「EULA」の対象となるソフト

ウェアコンポーネントのお問い合わせに関しては、10.4項に記載の方法でお問い合わせください。 

TeliCamSDK で使用している、対象となるソフトウェアコンポーネントの「EULA」は以下のディレクトリ

にインストールされています。 

Windows版  ： [TeliCamSDK インストールフォルダ]¥Licenses  

Linux版  ： /opt/TeliCamSDK/licenses  

  

東芝テリー株式会社は、東芝テリー株式会社が定める条件の基で TeliCamSDK の動作を保証します。（以下

のドキュメントをご覧ください。 

Windows版  ： ”License Agreement TeliCamSDK Jpn.txt”, 

     “License Agreement TeliCamSDK Sample Jpn.txt” 

Linux版  ： ”License Agreement TeliCamSDK for Linux Jpn.txt”, 

     “License Agreement TeliCamSDK for LinuxSample Jpn.txt” ) 

ただし、「EULA」に基づいて配布されるソフトウェアコンポーネントには、著作権者または弊社を含む第三

者の保証がないことを前提に、お客様がご自身でご利用になられることが認められるものであります。 こ

の場合、当該ソフトウェアコンポーネントは無償でお客様に使用許諾されますので、適用法令の範囲内で、

当該ソフトウェアコンポーネントの保証は一切ありません。 ここでいう保証とは、市場性や特定目的適合

性についての黙示の保証も含まれますが、それに限定されるものではありません。 当該ソフトウェアコン

ポーネントの品質や性能に関するすべてのリスクはお客様が負うものとします。 また、当該ソフトウェア

コンポーネントに欠陥があると分かった場合、それに伴う一切の派生費用や修理・訂正に要する費用は、東

芝テリー株式会社は一切の責任を負いません。 適用法令の定め、または書面による合意がある場合を除き、

著作権者や上記許諾を受けて当該ソフトウェアコンポーネントを使用したこと、または使用できないことに

起因する一切の損害について何らの責任も負いません。著作権者や第三者が、そのような損害の発生する可

能性について知らされていた場合でも同様です。なお、ここでいう損害には、通常損害、特別損害、偶発損

害、間接損害が含まれます（データの消失、またはその正確さの喪失すべて、お客様や第三者が被った損失、

他のソフトウェアとのインターフェースの不適合化等も含まれますが、これに限定されるものではありませ

ん）。 当該ソフトウェアコンポーネントの使用条件や遵守いただかなければならない事項等の詳細は、各

「EULA」をお読みください。  

 

TeliCamSDK で使用している「EULA」の対象となるソフトウェアコンポーネントは、以下の表のとおりで

す。 これらのソフトウェアコンポーネントをお客様自身でご利用いただく場合は、対応する「EULA」を

よく読んでから、ご利用くださるようお願いいたします。 
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Windows版 

対応ソフトウェアモジュール ライセンス 

GenICam GenApi GenICam License 

 

Linux版 

対応ソフトウェアモジュール ライセンス 

libteliusb (libusb) LGPLv2.1 

GenICam GenApi GenICam License 

Qt LGPLv3 

 

GenICam GenApi は以下のサードパーティソフトウェアを使用しています。 

対応ソフトウェアモジュール ライセンス 

MathParser LGPLv2.1 

Log4Cpp LGPLv2.1 

CppUnit  LGPLv2.1 

CLSerAll NI license 

xs3p DSTC license 

xxhash xxhash license 

XSLTProc MIT license 

XSDe Proprietary 

 

TeliViewer は以下のサードパーティソフトウェアを使用しています。 

Windows版 

対応ソフトウェアモジュール ライセンス 

Qt LGPLv3 

Qwt Qwt License 

OpenGL MIT license 

GStreamer LGPLv2 

 

Linux版 

対応ソフトウェアモジュール ライセンス 

libjpeg-turbo 

IJG (Independent JPEG Group) License * 1 

Clause 2 of the Modified BSD License * 2 

zlib license 

libdouble-conversion1 BSD-3-clause 

Qt LGPLv3 

Qwt Qwt License 

OpenGL MIT license 

GStreamer LGPLv2 

* 1 This software is based in part on the work of the Independent JPEG Group. 

* 2 10.3項に記載された licensesフォルダ内の、libjpeg-turbo/LICENSE.mdファイル内に記載され

ている “The Modified (3-clause) BSD License”の項目をご確認下さい。 
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TeliCamSDKは、LGPL適用ソフトウェアのバイナリを再配布しており、これらのソースコードに限っては、 

LGPLの定めに従い、入手、改変、再配布する権利をお客様は有します。 

ソースコードはご希望のお客さまへは、メディア（CD-ROM 等）に書き込み郵送にてお送りします。 

送料等実費にてご提供させていただいておりますので、ご希望の場合は 10.4 項に記載の方法でお問い

合わせください。 尚、ソースコードは、お客様が入手の権利を有するオープンソースソフトウェアのみ配

布いたします。（TeliCamSDK のソースコードは含まれません。） ソースコードの内容などについてのご

質問にはお答えいたしかねますので、あらかじめご了承ください。 

 

Microsoft、Windows、Windows XP、Windows Vista、Windows 7、Windows 8.1、Windows 10、Windows 11

及び、Visual  C++は、Microsoft 社の商標もしくは登録商標です。 

GigE Visionは、AIA (Automated Imaging Association)の各国における商標または登録商標です。 

USB3 Visionは、AIA (Automated Imaging Association)の各国における商標または登録商標です。 

GenICamは、EMVA (European Machine Vision association)の各国における商標または登録商標です。 

CoaXPressは、JIIA (Japan Industrial Imaging Association)の登録商標です。 

その他、本ドキュメントに記載の会社名、団体名、製品名、規格名等の名称は、各社各団体における商標ま

たは登録商標です。 

 

 

10.4. お問い合わせ  

TeliCamSDK ならびにGigE カメラ、USB3 カメラ、CoaXPress カメラに関するよくあるご質問とその回答

(FAQ)は、弊社ホームページの「サポート」 － 「産業カメラに関するFAQ」サイトをご利用ください。 

それでも解決できない場合は、弊社ホームページの「お問い合わせ」サイトに記載の電話番号またはメール

フォームにてご連絡ください。 

https://www.toshiba-teli.co.jp/
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